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About this guide
This guide provides service and maintenance information for the HP Z210 Convertible Mini Tower
(CMT) Workstation. It includes these topics:
Guide topics
Product overview on page 1
Setting up the operating system on page 16
Restoring the operating system on page 22
System management on page 25
Replacing components on page 53
Diagnostics and troubleshooting on page 109
Configuring RAID devices on page 146
Configuring password security and resetting CMOS on page 150
Connector pins on page 154
System board designators on page 161
Routine Care on page 163
Locating HP resources on page 165
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Product overview
This chapter presents an overview of the hardware components of the workstation. It includes these
topics:
Topics
Product features on page 1
Workstation specifications on page 7

Product features
The following sections describe the workstation system board architecture and components, and
includes these topics:
Topics
System board architecture on page 1
Workstation components on page 4

System board architecture
This section describes the system architecture.
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The following figure shows the typical system board block diagram.
Figure 1-1 System board block diagram

NOTE: The x1, x4, and x16 designators describe the mechanical length of the slot. The number in
parentheses lists the number of electrical PCIe lanes routed to the expansion slot. For example, x16(4)
means that the expansion slot is mechanically a x16 length connector, with four PCIe lanes connected.

Processor technology
This workstation uses the latest 32nm process SKT-H2 chipset, with support for the Intel® Xeon®
Processor E3 Family or 2nd generation Intel Core(TM) processors up to 95W. These processors
incorporate an integrated 2-channel memory controller, microarchitecture improvements, integrated
graphics (some models) and Advanced Vector Extensions (AVX) to increase floating point performance.
In addition, the chipset uses the Intel DMIx4 interface to connect the processor and I/O controller.

Memory technology
The workstation dual in-line memory modules (DIMMs) are based on DDR3 1066/1333MHz
technology. Error checking and correcting (ECC) and non-ECC DIMMs are supported. Two direct-attach
memory channels permit low latency access and fast data transfer to improve performance. System
memory sizes up to 32GB (using 8GB DIMMs) are supported.
NOTE: To optimize performance, distribute the DIMMs across both memory channels. See Memory
on page 83 for more information.

2
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NOTE: Do not intermix non-ECC memory DIMMs with ECC memory DIMMs.

Graphics
The workstation supports discrete PCIe Gen2 graphics cards in its PCIe2 x16 and PCIe2 x16(4) slots.
The system supports multiple graphics cards as long as the total power usage of these cards fits within
the total graphics power budget of 150W.
To view supported graphic card configurations using HP QuickSpecs, visit http://www.hp.com/go/
quickspecs, select your geographic region, click on "Workstations," then select your workstation model.
Some workstation models (depending on installed processor type) also support up to two displays with
integrated Intel HD graphics. Most supported Intel Core processors provide Intel HD Graphics 2000.
Intel Xeon processors with model designations that end in "---5" provide Intel HD Graphics P3000. In
Windows 7, you can view the model of CPU installed in the workstation by selecting Start > Control
Panel > System.
NOTE: Intermixing integrated Intel HD graphics and discrete graphics cards in order to drive more
than two displays can be enabled using the Computer (F10) Setup Utility. However, HP recommends
using only discrete graphics cards when attaching three or more displays. To see graphics card
configurations that have been fully tested and validated by HP for use in this workstation, refer to
http://www.hp.com/go/quickspecs.

Expansion card slots
The workstation provides multiple high-performance graphics and I/O slots: one full x16 PCIe2; one
x16(4) PCIe2, one x8(4) PCIe2; two x1 PCIe2; and two PCI 32b/33Mhz slots. These slots provide
extra I/O bandwidth for high speed I/O cards.

Additional features
The workstation provides these additional features:
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●

Nine external and three internal USB 2.0 ports.

●

A 400W power supply that is 90% efficient and permits Energy Star Version 5.0 system
configurations.

●

HP WattSaver technology permits support of the European Union ERP Lot 6 tier 2 power limit of
0.5W in off mode.

●

HP Quiet Fan Technology permits quiet system operation.

●

Parallel and serial headers that can be used with an optional PCI bulkhead connector.

Product features
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Workstation components
This section describes the workstation components, including front and rear panel components.
For complete and current information on supported accessories and components for the workstation,
see http://partsurfer.hp.com.

Chassis components
The following figure shows the chassis components of a typical HP Z210 CMT Workstation layout.
Drive configurations can vary.
Figure 1-2 Workstation chassis components

Table 1-1 Workstation component descriptions
Item

4

Description

Item

Description

1

Power supply

8

Memory module (DIMM)

2

Side access panel

9

PCIe card

3

Rear system fan

10

PCI card

4

Optical drive

11

Speaker

5

Processor heatsink

12

Hard disk drive

6

Processor (CPU)

13

Front bezel

7

System board

14

Chassis
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Front panel components
The following figure shows the front panel of an HP Z210 CMT Workstation. Drive configurations can
vary.
Figure 1-3 Workstation front panel

Table 1-2 Workstation front panel connectors
Item
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Symbol

Description

Item

Symbol

Description

1

Optical drive manual eject

6

Headphone connector

2

Optical drive eject button

7

Microphone connector

3

Power button

8

1394a connector (optional and
plugged unless configured)

4

Hard drive activity light

9

Optical drive activity light

5

USB 2.0 ports (3)

10

Optical drive

Product features
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Rear panel components
The following figure shows the rear panel of a typical HP Z210 CMT Workstation.
Figure 1-4 Workstation rear panel

NOTE: The labels for the rear panel connectors use industry-standard icons and colors.
Table 1-3 Rear panel components
Item

6

Symbol

Description

Item

Description
Microphone connector (pink)

1

Power supply fan

2

PS/2 mouse connector (green)

10

USB 2.0 ports (4)

3

Universal chassis clamp opening

11

USB 2.0 ports (2)

4

Cable lock slot

12

Display Port (DP) connector

5

Padlock loop

13

DVI-I connector

6

RJ-45 network connector

14

PS/2 keyboard connector (purple)

7

Audio line-in connector (blue)

15

Power cord connector

8

Audio line-out connector (green)

16

Power Supply BIST LED

Chapter 1 Product overview
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Workstation specifications
This section provides workstation chassis, power supply, and environmental specifications.

Physical characteristics
The following table lists the workstation physical characteristics.
Weight (Typical configuration)

10.4-14.8 kg (22.9-32.5 lb)

Chassis Dimensions

Height: 44.8 cm (17.6 in)
Width: 17.8 cm (7.0 in)
Depth: 45.4 cm (17.9 in)

Power supply description
The workstation includes a 400W 90% efficient 80PLUS gold-level power supply, which is compatible
with ENERGY STAR requirements.

Power supply voltages
Table 1-4 Power supply source voltages
Source voltage
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Description

V12CPU

Input to onboard regulator that supplies power to CPU and CPU fan

V12-B

Storage (hard disk drive, optical disk drive, diskette drive), PCIe slots,
system fans

V12 S

Input to onboard regulators

V12–G

Auxilliary power for graphics

V12N

PCI and serial port

11VSB

Input for sleep circuitry

Workstation specifications
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Power supply currents
Table 1-5 Maximum current per rail
Output (400W)

V12CPU

V12–B

V12–S

V12–G

V12N

11VSB

Nominal output
voltage

12.0

12.0

12.0

12.0

–12.0

11.4

18A

18A

18A

12.5A

0.15A

1.74A

Maximum
continuous
current

33.3A combined

CAUTION: Do not exceed 400 watts of total continuous output power.
Maximum combined current on +12V (CPU,B,S,g) is 33.3A.

8
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Power supply specifications
Table 1-6 Power supply specifications
Item

Description

Power supply

400W Wide Ranging, Active PFC and 90% efficient at typical
loads

Operating voltage range

90–269 VAC

Rated voltage range

100–240 VAC

Rated line frequency

50–60 Hz

Operating line frequency range

47–63 Hz

Rated input current

6A @ 100-127 VAC
3A @ 200–240 VAC

Heat dissipation

Typical: 985 btu/hr

(Configuration and software dependent)

Maximum 1569BTU/hr = (395.4 kg-cal/hr)

Power supply fan

One fan, 92mm x 25mm, variable speed

ENERGY STAR Qualified (Config dependent)

Yes

80 PLUS® Compliant

Yes, Gold-level rating

FEMP Standby Power compliant @115V (<2W in
S5 – Power Off)

Yes

ERP Lot 6 Tier 1 Compliant@ 230V (<1W in S5
– Power Off)

Yes

ERP Lot 6 Tier 2 Compliant @ 230V (<0.5W in
S5 – Power Off)

Yes

Built-in Self Test LED

Yes

Surge tolerant full ranging power supply
(withstands power surges up to 2000V)

Yes

Power Consumption in sleep mode (as defined
by ENERGY STAR) - Suspend to RAM (S3)
(Instantly Available PC)

<4W

Power consumption and heat dissipation
Power consumption and heat dissipation specifications are available for multiple configurations. To
review available specifications, see http://www.hp.com/go/quickspecs.
To reach zero power consumption, unplug the workstation from the power outlet or use a power strip
with an on/off switch. For additional information about power-saving features, see the operating system
installation instructions.
This product is in compliance with U.S. Executive Order 13221.

ENWW

Workstation specifications

9

System fans
This workstation includes:
●

One rear system fan

●

One CPU heatsink fan

●

One power supply fan

In addition, an optional front system fan is available for special environments, and many graphics
cards include onboard fans.

Resetting the power supply
If an overload triggers the power supply overload protection, power is immediately disconnected.
To reset the power supply:
1.

Disconnect the power cord from the workstation.

2.

Determine what caused the overload and fix the problem. For troubleshooting information, see
Diagnostics and troubleshooting on page 109.

3.

Reconnect the power cord and restart the workstation.

When you power off the workstation through the operating system, power consumption falls below
what is considered low power consumption but does not reach zero. This low power consumption
feature extends the life of the power supply.

10
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Environmental specifications
The following table lists the environmental specifications of HP Workstations.
Table 1-7 HP Workstation environmental specifications
Operating: 5 to 35°C (40 to 95°F)
Temperature

Non-operating: -40 to 60°C (-40 to 140°F)
NOTE: Derate by one degree C (1.8 degrees F) for every 305m (1,000 ft) altitude over
1,524m (5,000 ft).

Humidity

Altitude

Operating: 8 to 85% Relative Humidity (RH), non-condensing
Non-operating: 8 to 90% Relative Humidity, non-condensing
Operating: 0 to 3,048m (10,000 ft)
Non-operating: 0 to 9,144m (30,000 ft)
Operating: ½-sine: 40g, 2-3ms
Non-operating:

Shock

●

½-sine: 160 cm/s, 2-3ms (~100g)

●

square: 422 cm/s, 20g

NOTE:

Values represent individual shock events and do not indicate repetitive shock events.

Operating Random: 0.5g (rms), 5-300 Hz
Vibration

Non-Operating: random: 2.0g (rms), 10-500 Hz
NOTE:

ENWW

Values do not indicate continuous vibration.
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ENERGY STAR Qualification
HP computers marked with the ENERGY STAR logo are compliant with the applicable U.S.
Environmental Protection Agency (EPA) ENERGY STAR specifications for computers. The EPA ENERGY
STAR logo does not imply endorsement by the EPA. As an ENERGY STAR Partner, Hewlett-Packard
Company has determined the products marked with the ENERGY STAR logo are ENERGY STAR
qualified per the applicable ENERGY STAR guidelines for energy efficiency. The following logo
appears on all ENERGY STAR qualified computers.

The ENERGY STAR Computers Program was created by the EPA to promote energy efficiency and
reduce air pollution through more energy-efficient equipment in homes, offices, and factories. One way
products achieve this energy efficiency is by reducing power consumption when not being used through
the Microsoft Windows Power Management feature.
The Power Management feature enables the computer to enter a low-power (or “sleep”) mode after a
period of inactivity. When used with an external monitor that is ENERGY STAR qualified, this feature
also supports the similar power management features of the external monitor.
To take advantage of this energy savings:
●

The Power Management feature has been preset to suspend the computer to a sleep state after 30
minutes of inactivity.

●

The Power Management feature has been preset to suspend the monitor to a sleep state after 15
minutes of inactivity.

Both the computer and monitor can be woken from sleep mode through user interaction with any of the
computer input devices (mouse, keyboard, and so on). when configured with Wake On LAN (WOL)
enabled, the computer can also be woken by a network signal.
See the EPA ENERGY STAR Power Management Web site for more information about the energy and
financial savings potential of the Power Management Feature: http://www.energystar.gov/
powermanagement.
See the EPA ENERGY STAR Web site for more information about the ENERGY STAR program and its
environmental benefits: http://www.energystar.gov.
CAUTION: Using the Energy Save Monitor feature with monitors that are not ENERGY STAR
qualified can cause video distortion when an Energy Save timeout occurs.
NOTE:

ENERGY STAR is not supported on Linux computers.

If it is necessary to restore the operating system, you must also reset the ENERGY STAR settings (if
applicable) after the restore.
To verify the factory default power settings for your computer, select Start>Control Panel, and then
double-click Power Options.

12
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ERP compliance mode
This computer provides ERP compliance mode capability.
When enabled, this feature enables the computer to shut down to the lowest possible power state by
removing all power to the system board.
When disabled, the computer powers down conventionally.
When the computer is shut down in ERP compliance mode, it must be powered up with the computer
power button.

Enabling ERP compliance mode
To enable ERP compliance mode:
1.

Press F10 during start up.

2.

Using the arrow keys, select the Power>Hardware Power Management>S5 Maximum
Power Savings, and then select Enable.

3.

Press F10 to accept the change.

4.

Select File>Save Change and Exit, and then press F10 to accept the change.

Disabling ERP compliance mode
To disable the ERP compliance mode:
1.

Press F10 during start up.

2.

Select Power>Hardware Power Management>S5 Maximum Power Savings, and
then select Disable.

3.

Press F10 to accept the change.

4.

Select File>Save Change and Exit, and then press F10 to accept the change.

Accessibility
HP is committed to developing products, services, and information that is easier to access for all
customers, including customers with disabilities and age-related limitations. HP products with
Windows® 7 preinstalled are designed for accessibility. These products are tested with industryleading Assistive Technology products. For more information see http://www.hp.com/accessibility.

Hyper-threading
This HP computer supports Hyper-threading.
Hyper-Threading Technology (HTT), is an Intel-proprietary technology used to provide process
parallelization . The technology improves processor performance under certain workloads by providing
useful work for execution units that would otherwise be idle. A processor with Hyper-Threading enabled
is treated by the operating system as two processors instead of one. Hyper-threading relies on support
in the operating system as well as the CPU.

ENWW
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SATA Power Management
SATA Power Management enables or disables SATA bus and/or device power management.

Intel Turbo Boost Technology
The HP Z Workstation series supports Intel® Turbo Boost Technology.
This feature enables the CPU to run at a higher than normal rate. When all CPU cores are not
necessary for the workload, inactive cores are turned off and power is diverted to the active cores to
increase their performance.
Turbo Boost is enabled and disabled in computer BIOS.

HP Cool Tools
HP workstations and computers installed with Windows include additional software tools. To access or
learn more about these tools that can enhance the computer experience:

14

1.

Double-click the HP Cool Tools icon on the desktop.

2.

To learn more about an HP Cool Tool application, just click on the application's "Learn More"
link.

3.

To install or launch the applications, select the appropriate application and follow the instructions
given.

Chapter 1 Product overview
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Ensuring proper ventilation
Proper ventilation for the system is important for workstation operation. Follow these guidelines to
ensure adequate ventilation:
●

Operate the workstation on a sturdy, level surface.

●

Place the workstation in an area with adequate ventilation. Provide at least 15.24 cm (6 inches) of
clearance at the front and back of the workstation as shown in the following figure.
Your workstation might look different than the one shown.
Figure 1-5 Proper workstation ventilation

●

Ensure that the ambient air temperature surrounding the workstation falls within the published limit.
NOTE: The ambient upper limit of 35 C is only good up to 1524 m (5000 ft) elevation. There is
a 1 C per 304.8 m (1000 ft derating above 1524 m (5000 ft). So, at 3,048 m (10,000 ft), the
upper ambient air temperature limit is 30 C.

●

For cabinet installation, ensure adequate cabinet ventilation and ensure that the ambient
temperature within the cabinet does not exceed published limits.

●

Never restrict the incoming or outgoing airflow of the workstation by blocking any vents or air
intakes as shown in the following figure.
Figure 1-6 Proper workstation placement

ENWW

Workstation specifications

15

2

Setting up the operating system
This chapter provides setup and update information for the workstation operating system. It includes
these topics:
Topics
Setting up the Microsoft operating system on page 17
Setting up Red Hat Enterprise Linux on page 18
Setting up Novell SLED on page 19
Updating the workstation on page 20

This chapter also includes information on how to determine that you have the latest BIOS, drivers, and
software updates installed on the workstation.
CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.
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Setting up the Microsoft operating system
When you first apply power to the workstation, the operating system is installed. This process takes
approximately 5 to 10 minutes. Carefully follow the instructions on the screen to complete the
installation.
CAUTION: After installation has started, do not turn off the workstation until the process is complete.
Turning off the workstation during installation can damage the installation and operation of the
software.
For complete operating system installation and configuration instructions, see the operating system
documentation that was provided with the workstation. Additional information is available in the online
help tool after you successfully install the operating system.

Installing or upgrading device drivers
To install hardware devices after the operating system is installed, you must install the appropriate
device drivers before you install the devices. Follow the installation instructions that came with the
device. In addition, for optimum performance, your operating system must have the most recent
updates, patches, and software fixes. For additional driver and software update information, refer to
Upgrading device drivers on page 21.

Transferring files and settings to your Windows workstation
The Microsoft Windows operating system offers data migration tools that helps you choose and transfer
files and data from another Windows computer to your Windows operating system workstation.
For instructions on how to use these tools, see the documents at http://www.microsoft.com.
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Setting up Red Hat Enterprise Linux
HP offers an HP Installer Kit for Linux (HPIKL) to supplement Red Hat box sets and help HP Linux
customers customize their system image. The HPIKL contains the HP driver CD and device drivers to
successfully set up the Red Hat Enterprise Linux (RHEL) operating system. The HP Installer Kit for Linux
CDs are currently available for download at http://www.hp.com/support/workstation_swdrivers.
To use the drivers in the HP Installer kit for Linux other than RHEL, you must manually extract the drivers
from the HP Driver CD and install them. HP does not test the installation of these drivers on other Linux
distributions nor does HP support this operation.

Verifying hardware compatibility
To see which Linux versions have been qualified to work on HP Workstations visit http://www.hp.com/
support/linux_hardware_matrix.

Installing from RHEL optical media
When installing RHEL on your workstation, follow this procedure prior to booting and installing from the
RHEL box set media:
1.

With the RHEL install media in the DVD drive, restart the workstation and press the F9 key within
three seconds to display the boot menu. If you miss the boot menu, press Ctrl-Alt-Del to restart
and wait slightly more or less before pressing F9.

2.

From the list of available boot sources, under Legacy boot sources, pick the optical drive that
contains the RHEL install media.
NOTE: Be sure to pick from the list labeled Legacy boot sources when selecting the optical
drive from which to boot. Do not select from UEFI boot sources. Doing so may result in the OS
installation being unable to complete.

3.

Press Enter to continue with system boot and the OS installation process.

Installing with the HP driver CD
For instructions on installing the HP driver CD, see “Installing with the HP Installer Kit for Linux” in the
HP Workstations for Linux User Guide at http://www.hp.com/support/linux_user_manual.
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Setting up Novell SLED
The workstation can be ordered with Novell SLED preloaded.
HP offers an HP Installer Kit for Linux (HPIKL) to help HP Linux customers customize their system image.
The HPIKL contains the HP driver CD and device drivers to successfully set up the SUSE Linux Enterprise
Desktop (SLED) operating system. The HP Installer Kit for Linux CDs are currently available for
download at http://www.hp.com/support/workstation_swdrivers.

Setting up SLED on preloaded systems
To set up the SUSE Linux Enterprise Desktop (SLED) on systems preloaded with the operating system:
1.

Boot the workstation.

2.

Start the Installation Settings and enter the password, network, graphics, time, keyboard settings,
and Novell Customer Center Configuration for the workstation.
NOTE: During Installation Settings the Novell subscription can be activated from the Novell
Customer Center Configuration screen. Visit the full Novell Customer Center documentation at
http://www.novell.com/documentation/ncc/.

Installing from SLED optical media
To install SLED on your workstation, follow this boot procedure prior to installing from the SLED media:
1.

With the SLED install media in the DVD drive, restart the workstation and press the F9 key within
three seconds to display the boot menu. If you miss the boot menu, press Ctrl-Alt-Del to restart
and wait slightly more or less before pressing F9.

2.

From the list of available boot sources, under Legacy boot sources, pick the optical drive that
contains the SLED install media.
NOTE: Be sure to pick from the list labeled Legacy boot sources when selecting the optical
drive from which to boot. Do not select from UEFI boot sources. Doing so may result in the OS
installation being unable to complete.

3.

Press Enter to continue with system boot and the OS installation process.

Installing with the HP driver CD
For instructions on installing the HP driver CD, see “Installing with the HP Installer Kit for Linux” in the
HP Workstations for Linux User Guide at http://www.hp.com/support/linux_user_manual.
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Updating the workstation
HP is constantly working on improving your total workstation experience. To ensure that the workstation
leverages the latest enhancements, HP recommends that you install the latest BIOS, driver, and software
updates on a regular basis.

Updating the workstation after first boot
After successfully booting the workstation for the first time, you should follow these guidelines to ensure
that the workstation is up-to-date:
●

Ensure that you have the latest system BIOS loaded. See Upgrading the BIOS on page 20 for
instructions.

●

Ensure that you have the latest drivers for your system. See Upgrading device drivers
on page 21 for instructions.

●

Become familiar with your available HP resources.

●

Consider a subscription to Driver Alerts at http://www.hp.com/go/subscriberschoice.

Upgrading the BIOS
For optimum performance, determine the BIOS revision on the workstation, and upgrade it if necessary.

Determining current BIOS
To determine the current BIOS of the workstation during system power up:
1.

Wait for F10=setup to appear on the lower right corner of the screen.

2.

Press F10 to enter the F10 Setup utility.
The F10 Setup utility displays the workstation BIOS version under File > System Information.

3.
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Note the workstation BIOS version so that you can compare it with the BIOS versions that appear
on the HP website.
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Upgrading BIOS
To find and download the latest available BIOS, which includes the latest enhancements:
1.

Go to http://www.hp.com/go/workstationsupport.

2.

Select Download Drivers and Software from the left menu column under Tasks.

3.

Follow the instructions to locate the latest BIOS available for the workstation.

4.

If the BIOS on the Web site is the same as the version on your system, no further action is
required.

5.

If the BIOS on the Web site is a version later than the one on your system, download the
appropriate version for the workstation. Follow the instructions in the release notes to complete the
installation.

Upgrading device drivers
If you install a peripheral device (such as a printer, display adapter, or network adapter), confirm you
have the latest device drivers loaded. If you purchased your device through HP, visit the HP Web site to
download the latest drivers for your device. These drivers have been tested to ensure the best
compatibility between your device and your HP workstation.
If you did not purchase your device from HP, HP recommends visiting the HP Web site first to see if
your device and its drivers have been tested for HP workstation compatibility. If no driver is available,
visit the device manufacturer's Web site to download the latest drivers.
To upgrade device drivers:
1.

Go to http://www.hp.com/go/workstationsupport.

2.

Select Download Drivers and Software from the left menu column under Tasks.

3.

Follow the instructions to find the latest drivers available for the workstation.

If a needed driver is not found, see the Web site of the manufacturer of the peripheral device.
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3

Restoring the operating system
This chapter describes how to restore the Windows or Linux operating system. It includes these topics:
Topics
Restore method on page 22
Ordering backup software on page 23
Restoring Windows 7 on page 23
Restoring Novell SLED on page 24

Restore method
The Windows 7 operating system can be reinstalled using the HP Recovery Manager
HP Recovery Manager reinstalls the Windows operating system and device drivers (for devices
included with the system) to a near-factory state. The process does not back up or recover data on the
hard drive. Some application software might not be restored using this process and must be installed
from the appropriate application CD.
CAUTION: This method restores the operating system, but not data. Data must be backed up
regularly to avoid loss.
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Ordering backup software
You can order a recovery disk set from the HP support center. To obtain the support center telephone
number for your region see http://www.hp.com/support/contactHP. Request the Windows 7 32-bit or
64-bit system recovery media kit.

Restoring Windows 7
This section describes how to restore Windows 7.

Ordering the HP Recovery Manager media
If you ordered restore media with your workstation, the media is included with your workstation
components.
If you did not order restore media, call HP Support and request the Windows 7 32-bit or 64-bit system
recovery media kit. For worldwide technical support phone numbers, see http://www.hp.com/support.

Restoring the operating system
NOTE: Windows 7 provides a backup and restore application as well. To learn more about this
application, see the Microsoft Web site.
CAUTION: Before you restore the operating system, back up your data.
When you run HP Recovery Manager from media, the process deletes all information on the primary
hard drive, including all partitions.
To restore Windows 7:
1.

Boot from the first disk in the HP Recovery Manager DVD set to start the system recovery process.

2.

Follow the prompts to restore your operating system.

Some application software might not be restored using this process. If software is not restored, install it
from the appropriate application DVD.
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Restoring Novell SLED
The SLED restore media is required to restore the Linux operating system.

Creating restore media
The SUSE Linux Enterprise Desktop preload includes a SUSE ISO icon on the desktop. You can click this
icon to go to the /iso directory. The /iso directory contains all iso images used to preload your
workstation. To recover or restore the original image, follow the instructions in the readme file in the /
iso directory to copy the ISO image file onto a DVD.
NOTE: Make copies of the ISO recovery images on a DVD as backup files in case your workstation
experiences a hard drive failure.
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4

System management
This section describes the tools and utilities that provide system management for the workstation. It
includes these topics:
Topics
BIOS ROM on page 25
The Computer Setup (F10) Utility on page 25
Desktop management on page 36

BIOS ROM
The BIOS ROM is a collection of machine language applications stored as firmware in ROM. It includes
functions such as Power on Self Test (POST), PCI device initialization, Plug and Play support, power
management, and the Computer Setup (F10) Utility. The BIOS ROM is an 8MB Serial Peripheral
Interface (SPI) port.
See http://www.hp.com/go/quickspecs to review the latest BIOS ROM specifications.

The Computer Setup (F10) Utility
This section contains these topics:
Topics
Computer Setup (F10) functionality on page 25
Accessing the Computer Setup (F10) Utility on page 27
The Computer Setup (F10) Utility menu on page 28

Computer Setup (F10) functionality
The Computer Setup (F10) Utility enables you to:
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●

Change factory default settings and set or change the workstation configuration, which might be
necessary when you add or remove hardware.

●

Determine if all devices installed on the workstation are recognized by the system and functioning.

●

Determine information about the operating environment of the workstation.

●

Solve system configuration errors that are detected but not fixed during the Power-On Self-Test
(POST).

BIOS ROM
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●

Establish and manage passwords and other security features.

●

Establish and manage energy-saving time-outs (not supported on Linux platforms).

●

Modify or restore factory default settings.

●

Set the computer date and time.

●

Set, view, change or verify the computer configuration, including settings for CPU, graphics,
memory, audio, storage, communications and input devices.

●

Modify the boot order of installed mass storage devices such as SATA, optical disk drives, network
drives, and USB boot devices.

●

Configure the boot priority of SATA hard-drive controllers.

●

Enable or disable Network Server Mode, which enables the computer to start the operating system
when the power-on password is enabled with or without a keyboard or mouse attached. When
attached to the computer, the keyboard and mouse remain locked until the power-on password is
entered.

●

Enable or disable the display of POST messages. Disabling POST Messages suppresses most
POST messages, such as memory count, product name, and other non-error text messages. If a
POST error occurs, the error is displayed regardless of the mode selected. To manually switch to
POST Messages Enabled during POST, press any key except F1 through F12.

●

Specify an Ownership Tag, which appears when the computer is powered on or restarted.

●

Specify the Asset Tag or property identification number assigned by the company to this computer.

●

Enable power-on password prompts during system restarts (warm-starts) and power on.

●

Hide or show the integrated I/O functionality, including serial, USB, or parallel ports, audio, or
embedded NIC. Hidden devices are inaccessible, which increases system security.

●

Enable or disable removable media boot ability.

●

Enable or disable removable media write ability (if supported by hardware).

●

Replicate the computer setup by saving system configuration information on USB removeable
storage devices and restoring it on computers.

●

Execute self-tests on specified SATA hard disk drives (if supported by the drive).

Chapter 4 System management
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Accessing the Computer Setup (F10) Utility
To access the Computer Setup (F10) Utility menu:
1.

Power on or restart the computer.

2.

As the display first becomes active, press F10.
If you do not press F10 quickly enough at the appropriate time, try again. Turn the computer off,
then on, and press F10 again to access the utility. You can also press Ctrl + Alt + Delete before
starting if you miss the opportunity to press F10.

3.

Select the language from the list and press Enter.
In the Computer Setup (F10) Utility menu, five headings are displayed: File, Storage, Security,
Power, and Advanced.

4.

Use the left and right arrow keys to select the appropriate heading, use the up and down arrow
keys to select an option, and then press Enter.

5.

Choose from the following:
●

To apply and save changes, select File > Save Changes, and then select F10=YES.

●

To remove changes you have made, select Ignore Changes and then select F10=YES.

●

To reset to factory settings, select File > Default Setup > Restore Factory Settings as
Default. Press F10 to accept the changes, and then select Apply Defaults and Exit. This
restores the original factory system defaults.

NOTE: Help screens (accessed by pressing F1) are available for many menus in the Computer Setup
(F10) Utility.
CAUTION: Do not power off the computer while the ROM is saving the Computer Setup (F10) Utility
changes to CMOS memory. A loss of power could corrupt the CMOS memory. After you exit the F10
Setup screen, you can disconnect power from the computer.
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The Computer Setup (F10) Utility menu
The following table describes the functions available in the Computer Setup (F10) utility menu.
NOTE: With new BIOS releases, the following content is subject to change, so the menu might be
different than shown.
Table 4-1 Computer Setup (F10) Utility menu descriptions
Heading

Option

Description

File

System
Information

Displays the following system characteristics:
Product Name

●

SKU Number

●

Processor Type

●

Processor Speed

●

Processor Stepping (stepping designation and patch number)

●

Cache Size (L1/L2/L3)

●

Memory Size

●

Integrated MAC (onboard NIC)

●

System BIOS

●

Chassis Serial Number

●

Asset Tracking Number

●

ME (Intel Management Engine) Firmware Version

●

ME Management Mode

About

Displays copyright information.

Set Time and
Date

Lets you set system time and date. Use the keyboard Tab and arrow keys to make changes.

Flash System
ROM

Lets you upgrade the BIOS from a ROM image on optical media or USB.

Replicated Setup

Provides these options:

Default Setup

Apply Defaults
and Exit

28

●

●

Save to Removable Media—Saves the computer configuration, including CMOS, to a
USB storage device. The saved configuration file is named cpqsetup.txt.

●

Restore from Removable Media—Restores the computer configuration from a USB
storage device.

Provides these options:
●

Save Current Settings as Default—Saves the current settings as default settings for the
next operation.

●

Restore Factory Settings as Default—Restores the factory settings as the default settings
for the next operation.

Restores the default settings defined in Default Setup.

Chapter 4 System management
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Table 4-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Storage

Option

Description

Ignore Changes
and Exit

Exits computer setup without applying or saving changes.

Save Changes
and Exit

Saves changes to system configuration and exits the computer setup.

Device
Configuration

Lists installed SATA storage devices and provides specific information about each device:
●

Hard Disk—Provides information about the hard disk drives.

●

CD-ROM—Provides information about the optical disk drives.

●

Default Values—Resets devices to their default configuration (SATA is the default).
◦

Translation Mode2—Enables the BIOS to determine the translation mode used to
configure a formatted SATA or USB mass storage device. This prevents you from
needing to know how the mass storage device was formatted. Options are
Automatic (default), Bit Shift, LBA Assisted, User (Cylinders, Heads, Sectors), and
Off.
Ordinarily, you should not change the translation mode selected by the BIOS. If
the selected translation mode is not compatible with the translation mode that was
active when the drive was partitioned and formatted, the data on the disk
becomes inaccessible.

Storage Options

DPS Self-test

Provides these options:
●

Removable Media Boot (Enabled/Disabled)—Enabling allows the workstation to boot
from removable media, such as a USB flash drive.

●

SATA Emulation—Sets the SATA emulation mode with the following options:
◦

RAID + AHCI—both the RAID and AHCI OPROMs execute. This emulation mode is
the default and offers the best performance and most functionality.

◦

IDE—offers standard SATA support. Some higher-numbered SATA ports may not
be available in this mode.

●

eSATA Port—Displays the internal SATA port(s) that are configured to operate as
eSATA. Changing this to None provisions the port(s) as internal SATA.

●

Max eSATA Speed—Configures eSATA port speeds:
◦

Gen 2 (3.0 Gbps)

◦

Gen 1 (1.5 Gbps)

Select a drive—Lets you execute self-tests on SATA hard drives capable of performing Drive
Protection System (DPS) self-tests.
NOTE: This selection appears only when the system has one or more drives capable of
performing the DPS self-tests.
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Table 4-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description

Boot Order

Lets you configure the boot order by physically reordering the menu entries. The default boot
order is:
●

●

EFI Boot Sources
◦

USB Floppy/CD

◦

USB Hard Drive

◦

ATAPI CD/DVD Drive

Legacy Boot Sources
◦

ATAPI CD/DVD Drive

◦

USB Floppy/CD

◦

Hard Drive

◦

Network Controller

You can take the following actions:
●

Press Enter to drag a device with the arrow keys to a preferred place, then press Enter
again to drop the device in place.

●

Press F5 to remove the device from consideration as a bootable device.

●

You must confirm changes by selecting File>Save Changes and Exit and then press
Enter.The computer then stores boot order changes in the physical ROM.

To temporarily override the boot order and boot from a device other than the default device
specified in Boot Order:

Security

Setup Password

1.

Restart the computer.

2.

Press F9 when the F9=Boot Menu message appears on the screen.

3.

Wait for POST to finish and for the list of bootable devices to display.

4.

Use the arrow keys to select the preferred boot device.

5.

Press Enter. The computer then starts from the selected nondefault device. (This does not
change the default boot device.)

Lets you set and enable a setup password for the administrator.
If you create a setup password, you must use it to change computer setup options, to flash
the ROM, and to make changes to certain Plug and Play settings under Windows.

Power-On
Password
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Let you set and enable the power-on password.
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Table 4-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description

Password Options

This option becomes available depending on the presence of setup or power-on passwords.
It provides these options:
●

Lock Legacy Resources (Enabled/Disabled)—Prevents the operating system from
changing resources to serial, parallel, or diskette controller. (Appears if a setup
password is set.)

●

Setup Browse Mode (Enabled/Disabled)—Lets you view but not change the F10 Setup
Options without having to enter the setup password. (Appears if a setup password is
set.)

●

Password prompt on F9, F11, and F12 (Enabled/Disabled)—Lets you access menus
without entering the setup password.

●

Network Server Mode (Disabled/Enabled)—Enables network server mode. (Appears if
a power-on password is set.)

Smart Cover

Lets you enable/disable the cover removal sensor1.

Device Security

Makes the following devices available or hidden to the computer:
●

Embedded Security Device (hidden by default)

●

System Audio

●

Network Controller

●

SATA ports

With the exception of Embedded Security Device (TPM), Device Available is the default
setting for all devices (allows the operating system to access the device). Device Hidden
disables the device by the BIOS so that the operating system can no longer enable the
device.
NOTE: An entry for enabling DriveLock appears in the setup menu if the computer has a
DriveLock-compatible hard disk drive.
USB Security
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Set workstation USB ports to Enabled/Disabled:
●

Front USB Ports

●

Rear USB Ports

●

Accessory USB Ports

Slot Security

Lets you disable any PCI or PCI Express slot.

Network Boot

Lets you enable/disable the ability to boot from the network using the F12 key or the boot
order.

System IDs

Provides these options:
●

Asset Tag—A user-editable, 16-byte string identifying the computer.

●

Ownership Tag—A user-editable, 80-byte string identifying ownership of the computer.
This tag appears on the screen during POST.

●

Universal Unique Identifier (UUID)—An ID number set in the factory that uniquely
identifies the computer.

●

Keyboard—Lets you set the keyboard locale for System ID entry.

The Computer Setup (F10) Utility
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Table 4-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description

System Security

With the exception of the first option, Data Execution Prevention, changing any of these
system security settings and choosing File > Save Changes and Exit will result in the
computer performing a global reset, automatically turning itself off and then back on. Note
also that these options are hardware dependent and may not be available on some models:
●

Data Execution Prevention (Enabled/Disabled)—Helps prevent operating system
security breaches.

●

Virtualization Technology (VTx)1 (Disabled/Enabled)—Controls the virtualization
features of the processor.

●

Virtualization Technology Directed I/O (VTd)1 (Disabled/Enabled)—Controls
virtualization DMA remapping features of the chipset.

●

Intel TXT(LT) Support1 (Enabled/Disabled)—Controls the underlying processor and
chipset features needed to support a virtual appliance. To enable this feature you must
enable:

●

◦

Virtualization Technology (VTx)

◦

Virtualization Technology Directed I/O (VTd)

◦

Embedded Security Device

Embedded Security Device1 (Disabled/Enabled)—Permits activation and deactivation of
the Embedded Security Device.
NOTE: Embedded Security Device must be set to Device Available in the Device
Security menu, and you must create a Setup Password, in order to configure the
Embedded Security Device.

●

Reset to Factory Settings1 (Do not reset/Reset)—Restores factory defaults and erases all
security keys.
CAUTION: Choosing Reset to Factory Settings may result in significant data loss. The
embedded security device is a critical component of many security schemes. Erasing the
security keys prevent access to data protected by the Embedded Security Device.

●

OS Management of Embedded Security Device1 (Disabled/Enabled)—Limits operating
system control of the Embedded Security Device.

●

Reset of Embedded Security Device through OS1 (Enabled/Disabled)—Limits the
operating system ability to request a Reset to Factory Settings of the Embedded Security
Device.
NOTE:

Drive Lock
Security

You must create a Setup Password to use this option.

Lets you assign or modify a master password or user password for hard drives. When
enabled, this feature prompts the user to provide one of the DriveLock passwords during
POST. If the user does not successfully enter one of the passwords, the hard drive remains
inaccessible until one of the passwords is successfully entered during a subsequent cold-boot
sequence.
NOTE: This selection appears only when the system includes at least one drive that
supports the DriveLock feature.
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Table 4-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description

Power

OS Power
Management

Enables or disables:

Hardware Power
Management

Advanced2
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●

Runtime Power Management

●

Idle Power Savings: Extended (default) or Normal; extended mode reduces processor
power consumption when the CPU is idle

●

ACPI S3 PS2 Mouse Wakeup

●

Unique Sleep State Blink Rates

Enables or disables:
●

SATA Power Management

●

S5 Maximum Power Savings

Thermal

Lets you set the minimum speed of the system fan when the CPU is idle.

Power-On
Options

Sets the following:
●

POST Mode:
◦

QuickBoot—Do not clear memory or perform a memory test.

◦

FullBoot—Memory test (count) on cold boot. Clears memory on all boots.

◦

Clear Memory—No memory test (count) on cold boot. Clears memory on all
boots.

◦

FullBoot Every x Days—Memory count on first cold boot on or after the Xth day
and no more memory counts until that boot occurs. Clears memory on all boots.

●

POST Messages (Enabled/Disabled)

●

Press the ESC key for Startup Menu (Enabled/Disabled)

●

Option ROM Prompt (Enabled/Disabled)—Enabling this feature causes the computer to
display a message before loading option ROMs.

●

After Power Loss—Lets you specify computer behavior after a power loss:
◦

Power Off—Computer remains powered off when power is restored (default).

◦

Power On—Computer automatically powers on when power is restored. (This
lets you power on the computer using a power strip switch, if the computer is
connected to an electric power strip.)

◦

Previous state—Computer powers on automatically when power is restored
only if computer was on when power was lost.

The Computer Setup (F10) Utility
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Table 4-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description
NOTE: If you turn off power to the computer using a power strip, you cannot use
the suspend/sleep feature or the Remote Management features.
●

34

POST Delay (None (default), 5, 10, 15, 20 seconds)—Delays start of the POST
process. You might need a delay to:
◦

Allow time for some hard disk drives to spin up before POST is finished

◦

Give yourself more time to select F10 to enter the Computer Setup (F10) Utility.

●

Remote Wakeup Boot Source (Local Hard Drive/Remote Server). Sets the boot device
for the workstation when it is started using Remote Wakeup (takes precedence over the
Boot Order menu setting) .

●

System Recovery Boot Support (Enabled/Disabled). Enabling this feature displays an
additional prompt, F11=Recovery, during POST on systems with HP Backup and
Recovery software installed and configured with a recovery partition on the boot hard
drive. Pressing F11 causes the system to boot to the recovery partition and launch HP
Backup and Recovery. You can hide the F11=Recovery prompt by using the F11
prompt option described above.

●

Bypass F1 Prompt on Confirmation Changes (Enabled/Disabled)—Prevents display of a
confirmation prompt when you make changes to the system.

BIOS Power-On

Lets you disable or specify a weekday and time for BIOS power-on.

Onboard Devices

Lets you disable or set resources (IRQ, DMA, I/O Rate) for onboard system devices such as
the serial port and parallel ports. Operating system parameters generally override Onboard
Devices settings.

Bus options

Enable/disable these options:
●

PCI SERR# Generation (Enabled/Disabled)—Controls PCI SERR# generation for illbehaved PCI add-in cards (that can generate SERR# spuriously)

●

PCI VGA Palette Snooping (Disabled/Enabled)—Controls PCI VGA Palette Snooping
for compatibility purposes

●

PCI Latency Timer (32/64/128/160/192/224/248). 128 PCI Clocks is the default.
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Table 4-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description

Device Options

Enable/disable the following device options:
●

S5 Wake-on-LAN (Enabled/Disabled)

●

Turbo Mode (Enabled/Disabled)

●

Printer Mode (EPP+ECP, Output Only, Bi-Directional).

●

Num Lock State at Power-On (On/Off)

●

Integrated Video1 (Enabled/Disabled)

●

IGD (Integrated Graphics Device) Memory—Displayed when Integrated Video is
Enabled. Sets the maximum amount of system memory that can be allocated as
graphics memory (32, 64 (default), 128, 256, 512 MB)1

●

Internal Speaker (Enabled/Disabled)

●

NIC Option ROM2 Download (PXE/Disabled)

●

SATA RAID Option ROM2 Download (Enabled/Disabled)

●

Multi-Processor (Enabled/Disabled)

●

Hyperthreading1 (Disabled/Enabled)

Slot Settings

Lets you Enable/Disable Option ROM Download for each slot. Selective disabling of Option
ROM downloads can help manage limited Option ROM space.

AMT
Configuration

Lets you set the following AMT (Intel Active Management Technology) configuration options:
●

AMT (Enabled/Disabled)—Allows for remote discovery, repair and protection of
networked workstations. Enabling the AMT function also enables the Network Controller
(required for AMT to function correctly).

●

Unconfigure AMT/ME (Disabled/Enabled)2—Restores AMT/ME defaults. When you
save and exit after enabling this option, you will be prompted to complete the process
upon restart. A Setup Password (even if one is set) does not need to be entered to
complete the process.
NOTE:

●

1
2
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Information about Intel AMT can be found at www.intel.com.

WatchDog Timer (Enabled/Disabled)—OS and BIOS WatchDog Timers can be set
independently (in minutes):
◦

OS WatchDog Timer—Sets the OS WatchDog Timer

◦

BIOS WatchDog Timer—Sets the BIOS WatchDog Timer.

Available on selected models
These options should be used by advanced users only

The Computer Setup (F10) Utility
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Desktop management
This section summarizes capabilities, features, and key components of computer management,
including:
Topics
Initial computer configuration and deployment on page 37
Installing a remote system on page 37
Replicating the setup on page 38
Updating and managing software on page 39
HP Client Manager Software on page 39
Altiris Client Management Solutions on page 39
System Software Manager on page 40
ROM Flash on page 40
FailSafe Boot Block ROM on page 41
Workstation security on page 42
Fault notification and recovery on page 51
Dual-state power button on page 52

NOTE: Support for specific features described in this guide can vary by model and software version.
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Initial computer configuration and deployment
The computer includes a preinstalled system software image. After a brief software unbundling process,
the computer is ready to use.
If you prefer to replace the preinstalled software image with a customized set of system and application
software, several methods are available for deploying a customized software image, including:
●

Installing additional software applications after unbundling the preinstalled software image

●

Using a disk cloning process to copy the contents from one hard disk drive to another

The HP Recovery Manager DVDs, ROM-based setup, and ACPI hardware provide further assistance
with recovery of system software, configuration management and troubleshooting, and power
management.
Support for specific features described in this guide can vary by model and software version.
The best deployment method depends on the information technology environment and processes.

Installing a remote system
Remote system installation enables starting and setting up the computer using software and
configuration information on a network server. This feature is usually used as a system setup and
configuration tool and can be used for the following tasks:
●

Deploying a software image on new PCs

●

Formatting a hard disk drive

●

Installing application software or drivers

●

Updating the operating system, application software, or drivers

To initiate a remote system installation, press F12 when F12=Network Service Boot appears in the
lower right corner of the HP logo screen. Follow the onscreen instructions to continue the installation
process. The default boot order is a BIOS configuration setting that can be changed to always attempt
a PXE boot.
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Replicating the setup
This section provides information about replicating the computer setup.

Copying a setup configuration to another computer
CAUTION: A setup configuration is model-specific. File system corruption can result if source and
target computers are not the same model.
To copy a setup configuration:
1.

Select a setup configuration to copy, and then restart the computer.

2.

As soon as the computer powers on, press and hold F10 until you enter the Computer Setup (F10)
Utility. If necessary, press Enter to bypass the title screen.
NOTE: If you do not press F10 at the appropriate time, you must restart the computer, and then
press and hold F10 again to access the utility.
If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.
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3.

Select File>Replicated Setup>Save to Removable Storage Device. Follow the
instructions on the screen to create the configuration file cpqsetup.txtand write it to a USB storage
device.

4.

Power off the computer you are configuring and insert the removeable USB media device
containing the configuration file.

5.

Power on the computer you are configuring.

6.

Press and hold the F10 key until you enter the Computer Setup (F10) Utility. If necessary, press
Enter to bypass the title screen.

7.

Select File>Replicated Setup>Restore from Removable Storage Device, and then
follow the instructions on the screen.

8.

Restart the computer when the configuration is complete.
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Updating and managing software
HP provides several tools for managing and updating software on desktops and computers:
●

HP Client Manager Software

●

Altiris Client Management Solutions

●

HP SoftPaq Download Manager

●

System Software Manager

HP Client Manager Software
The HP Client Manager Software offers these services:
●

Detailed views of hardware inventory for asset management

●

PC health-check monitoring and diagnostics

●

Proactive notification of changes in the hardware environment

●

Web-accessible reporting of business-critical details such as thermal warnings and memory alerts

●

Remote updating of system software such as device drivers and ROM BIOS

●

Remote changing of boot order

●

Configuration of system BIOS settings

The HP Client Management Solutions (CMS), available for download from http://www.hp.com/go/
easydeploy, are standards-based solutions for managing and controlling computers in a networked
environment.
For more information about the HP Client Manager, see http://www.hp.com/go/ssm.

Altiris Client Management Solutions
Altiris and HP have partnered to provide comprehensive, tightly integrated systems management
solutions to reduce the cost of owning HP client PCs.
The HP CMS is the foundation for additional Altiris Client Management Solutions that address the
following topics.
●

Inventory and asset management

●

Deployment and migration

●

Help desk and problem resolution

●

Software and operations management

For more information about the following topics, go to http://www.hp.com/go/ssm.
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●

How HP CMS works

●

Which solutions are compatible with the operating system

●

How to download a fully functional, 30-day evaluation version of Altiris solutions
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HP SoftPaq Download Manager
HP SoftPaq Download Manager is a free, easy-to-use interface for locating and downloading software
updates for the HP client PC models in your environment. By specifying your models, operating system,
and language, you can quickly locate, sort, and select the softpaqs you need. To download HP SoftPaq
Download Manager, visit http://h20331.www2.hp.com/Hpsub/cache/509658-0-0-225-121.html.

System Software Manager
System Software Manager (SSM) is a utility available on Windows computers that enables you to
update system-level software on multiple systems simultaneously. When executed on a PC client system,
SSM detects hardware and software versions and then updates the software from a central repository,
known as a file store. Driver versions supported by SSM are noted with a special icon on the software,
the driver download Web site, and on the Support Software CD.
To download the utility or to obtain more information about SSM, see http://www.hp.com/go/ssm.

ROM Flash
HP computers include a programmable flash ROM. By establishing a setup password in the Computer
Setup (F10) Utility, you can protect the ROM from being inadvertently updated or overwritten. This
function is important to ensure the operating integrity of the computer.
To upgrade the ROM, download the latest SoftPaq images from http://www.hp.com/support/
workstation_swdrivers.
For maximum ROM protection, establish a setup password. The setup password prevents unauthorized
ROM upgrades. SSM enables you to create the setup password on several computers simultaneously.

Remote ROM Flash
Remote ROM Flash allows system administrators to safely upgrade the ROM on remote HP computers
from a centralized network management console, resulting in a consistent deployment of, and greater
control over, HP PC ROM images over the network.
To use Remote ROM Flash, the computer must be powered on, or turned on using Remote Wakeup.
For more information about Remote ROM Flash and HPQFlash, see the HP Client Manager Software or
System Software Manager sections at http://www.hp.com/go/ssm.

HPQFlash
The HPQFlash utility is used to locally update or restore the system ROM on PCs using a Windows
operating system. For more information about HPQFlash, see http://www.hp.com/go/ssm, and enter
the name of the computer.
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FailSafe Boot Block ROM
The FailSafe Boot Block ROM enables system recovery in the unlikely event of a ROM flash failure. For
example, if a power failure occurs during a ROM upgrade, the Boot Block uses a flash-protected
section of the ROM to verify a valid system ROM flash when power is restored to the computer.
If the system ROM is valid, the computer starts normally.
If the system ROM fails the validation check, the FailSafe Boot Block ROM provides enough support to
start the computer from a BIOS image CD created from a SoftPaq. The BIOS image CD programs the
system ROM with a valid image.
When Boot Block detects an invalid system ROM, the computer power LED blinks red eight times and
the computer beeps eight times; then the computer pauses for two seconds. On some models, a Boot
Block recovery mode message appears.
In preparation for system recovery, use the BIOS CD media file in the SoftPaq to create a BIOS image
CD.

Recovering the computer from Boot Block Recovery mode
To recover the computer after it enters Boot Block recovery mode:
1.

Remove any media such as USB keys or disks in the optical disk drives.

2.

Insert a BIOS image CD into the CD drive. You can also use USB media such as an HP DriveKey.

3.

Power off, then power on the computer.
If no BIOS image CD or USB media is found, you are prompted to insert one and restart the
computer.
If a setup password has been established, the Caps Lock light illuminates and you are prompted
for the password.

4.

Enter the setup password.
If the computer starts from the CD or USB media and successfully reprograms the ROM, three
keyboard lights illuminate. A rising-tone series of beeps also signals successful recovery.
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5.

Remove the CD or USB media and power off the computer.

6.

Restart the computer.
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Workstation security
This section provides information about providing system security through asset tracking, password
security, hard disk drive locking, and chassis locks.

Asset tracking
Asset tracking features incorporated into the computer provide asset tracking data that can be
managed using HP Systems Insight Manager (HP SIM), HP CMS, or other systems-management
applications.
Seamless, automatic integration between asset tracking features and these products enables you to
choose the management tool that is best suited to the environment and to leverage investments in
existing tools.
HP also offers several solutions for controlling access to valuable components and information:
●

HP ProtectTools Embedded Security prevents unauthorized access to data, checks system integrity,
and authenticates third-party users attempting system access.

●

Security features such as ProtectTools and the Side access panel sensor (Smart Cover Sensor) help
prevent unauthorized access to the data and to the internal components of the computer.

●

By disabling parallel, serial, or USB ports, or by disabling removable-media boot capability, you
can protect valuable data assets.

●

Memory Change and Side access panel sensor (Smart Cover Sensor) alerts can be forwarded to
system management applications to deliver proactive notification of tampering with a computer’s
internal components.

ProtectTools, the Side access panel sensor (Smart Cover Sensor), and the Side access panel solenoid
lock (Hood Lock) are available as options on select systems.
Use the following utilities to manage security settings on the HP computer:
●

Locally, using the Computer Setup (F10) Utility

●

Remotely, using the HP CMS or System SSM, which enables the secure, consistent deployment and
control of security settings from a simple command line utility

For more information about the Computer Setup (F10) Utility, see The Computer Setup (F10) Utility
menu on page 28.
The following table and sections refer to the management of computer security through the Computer
Setup (F10) Utility
Table 4-2
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Security features overview

Feature

Purpose

How it is established

Removable Media Boot Control

Prevents booting from removable media
drives

From the Computer Setup (F10)
Utility menu

Serial, Parallel, USB,
or Infrared Interface Control

Prevents transfer of data through the
integrated serial, parallel, USB, or infrared
interface

From the Computer Setup (F10)
Utility menu
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Table 4-2

Security features overview (continued)

Feature

Purpose

How it is established

Power-On Password

Prevents use of the computer until the
password is entered (applies to initial system
startup and restarts)

From the Computer Setup (F10)
Utility menu

Setup Password

Prevents reconfiguration of the computer (use
of the Setup utility) until the password is
entered

From the Computer Setup (F10)
Utility menu

Network Server Mode

Provides unique security features for
computers used as servers

From the Computer Setup (F10)
Utility menu

SATA hard disk drive security
HP computers include the HP DriveLock facility for SATA hard disk drives to prevent unauthorized
access to data.
WARNING! Enabling DriveLock can render a SATA hard disk drive permanently inaccessible if the
master password is lost or forgotten. No method exists to recover the password or access the data.
DriveLock has been implemented as an extension to Computer Setup (F10) functions. It is only available
when hard disk drives that support the ATA security command set are detected. On HP computers, it is
not available when the SATA emulation mode is RAID+AHCI or RAID.
DriveLock is for HP customers for whom data security is a paramount concern. For such customers, the
cost of a hard disk drive and the loss of the data stored on it is inconsequential when compared to the
damage that could result from unauthorized access to its contents.
To balance this level of security with the need to address the issue of a forgotten password, the HP
implementation of DriveLock employs a two-password security scheme. One password is intended to be
set and used by a system administrator, while the other is typically set and used by the user.
No "back door" can be used to unlock the drive if both passwords are lost. Therefore, DriveLock is
most safely used when the data contained on the hard disk drive is replicated on a corporate
information system or is regularly backed up.
If both DriveLock passwords are lost, the hard disk drive is rendered unusable. For users who do not fit
the previously defined customer profile, this might not be acceptable. For users who fit this profile, it
might be a tolerable risk, given the nature of the data stored on the hard disk drive.
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DriveLock applications
The most practical use of DriveLock is in a corporate environment. The system administrator would be
responsible for configuring the hard disk drive, which involves setting the DriveLock master password
and a temporary user password. If you forget the user password or if the equipment is passed on to
another employee, the master password can be used to reset the user password and regain access to
the hard disk drive.
HP recommends that corporate system administrators who enable DriveLock also establish a corporate
policy for setting and maintaining master passwords. This should be done to prevent a situation where
an employee sets both DriveLock passwords before leaving the company. In such a scenario, the hard
disk drive is unusable and requires replacement. Likewise, by not setting a master password, system
administrators might find themselves locked out of a hard disk drive and unable to perform routine
checks for unauthorized software, other asset control functions, and support.
For users with less stringent security requirements, HP does not recommend enabling DriveLock. Users in
this category include personal users, or users who do not maintain sensitive data on their hard disk
drives as a common practice. For these users, the potential loss of a hard disk drive resulting from
forgetting both passwords is much greater than the value of the data DriveLock protects.
Access to Computer Setup (F10) and DriveLock can be restricted through the setup password. By
specifying a setup password and not giving it to users, system administrators can restrict users from
enabling DriveLock.
Using DriveLock
When hard disk drives that support the ATA security command set are detected, DriveLock appears
under the Security menu in the Computer Setup (F10) menu. You are presented with options to set the
master password and to enable DriveLock. You must provide a user password to enable DriveLock.
Because the initial configuration of DriveLock is typically performed by a system administrator, a master
password should be set first.
HP encourages system administrators to set a master password whether they plan to enable DriveLock
or not. This gives the administrator the ability to modify DriveLock settings if the drive is locked in the
future. After the master password is set, the system administrator can enable DriveLock or leave it
disabled.
If a locked hard disk drive is present, POST requires a password to unlock the device. If a power-on
password is set and it matches the device’s user password, POST does not prompt the user to re-enter
the password. Otherwise, the user is prompted to enter a DriveLock password.
For a cold start, use the master or user password. For a warm start, enter the same password used to
unlock the drive during the preceding cold start.
Users have two attempts to enter a correct password. During cold start, if neither attempt succeeds,
POST continues but the drive remains inaccessible. During a warm-start or restart from Windows, if
neither attempt succeeds, POST halts and the user is instructed to cycle power.
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Enabling DriveLock
To enable and set the DriveLock user password:
1.

Power on or restart the computer.

2.

As soon as the computer is powered on, press and hold F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.
If you do not press F10 at the appropriate time, you must restart the computer, and then press and
hold F10 again to access the utility.
If you are using a PS2 keyboard, you might see a keyboard error message. Disregard it.

3.

Select Security>DriveLock Security.

4.

For each DriveLock-capable drive, select a drive by pressing F10 to accept.

5.

Under Enable/Disable DriveLock options, select Enable, and then press F10 to enable DriveLock
for a specific drive.
CAUTION:

Forgetting the DriveLock password renders the drive unusable.

6.

Enter a new user password, and then press F10 to accept. This password may be 1 to 32
characters long.

7.

Enter the password again in the Enter New Password Again field. If you forget this password, the
drive is rendered permanently disabled.

8.

Select File>Save Changes and Exit, and then press F10. After you press F10, the computer
performs a cold start before invoking the DriveLock function.
You can also use this process to set the DriveLock master password by selecting Master in Step
5.
When the computer starts, you are prompted to enter the DriveLock password for each DriveLockcapable drive for which you have set a password. You have two attempts to enter the password
correctly. If the password is not entered correctly, the computer attempts to start anyway.
However, the boot process most likely fails because data from a locked drive cannot be accessed.
In a single drive computer, if the drive has DriveLock enabled, the computer might not be able to
boot to the operating system, and might try to boot from the network or from another storage
device (depending on the boot ordering options). Regardless of the outcome of the start attempts,
the drive-locked drive remains inaccessible without the DriveLock password.
In a two-drive computer that has a boot drive and a data drive, you can apply the DriveLock
feature to the data drive only. In this case, the computer can always start, but the data drive is
accessible only when the DriveLock password is entered.
Cold starts require that you enter DriveLock passwords. However, DriveLock passwords are also
required for warm starts. For example, if you boot to DOS and press Ctrl+Alt+Del, you must enter
the DriveLock password before the computer completes the next start cycle. This warm-start
behavior is consistent with the DriveLock feature.

ENWW

Desktop management

45

Password security
The power-on password prevents unauthorized use of the computer by requiring entry of a password to
access applications or data when the computer is powered on or restarted. The setup password
specifically prevents unauthorized access to the Computer Setup (F10) Utility and can also be used as
an override to the power-on password. When prompted for the power-on password, entering the setup
password instead enables access to the computer.
You can establish a network-wide setup password to enable the system administrator to log in to all
network systems to perform maintenance without needing to know the power-on password.
Establishing a setup password using Computer Setup (F10) Utility
Establishing a setup password through the Computer Setup (F10) Utility prevents reconfiguration of the
computer (through the use of the Computer Setup (F10) Utility) until the password is entered.
To establish a setup password using the Computer Setup (F10) menu:
1.

Power on or restart the computer.

2.

As soon as the computer is powered on, press and hold F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.
If you do not press F10 at the appropriate time, you must restart the computer, and then press and
hold F10 again to access the utility.
If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.
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3.

Select Security>Setup Password and then follow the onscreen instructions.

4.

Before exiting, select File>Save Changes and Exit.
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Establishing a power-on password using computer setup
Establishing a power-on password through the Computer Setup (F10) Utility prevents access to the
computer when power is connected, unless you specify the password. When a power-on password is
set, the Computer Setup (F10) Utility presents Password Options in the Security menu. The password
options include Network Server Mode and Password Prompt on Warm Boot.
When Network Server Mode is disabled, you must enter the password when the computer is powered
on, when the key icon appears on the monitor. When Password Prompt on Warm Boot is enabled, you
must enter the password. The password must also be entered each time the computer is restarted.
When Network Server Mode is enabled, the password prompt is not presented during POST, but an
attached PS/2 keyboard remains locked until you enter the power-on password.
To enable Network Server Mode, you must set a power-on password under Advanced>Password
Options. This option enables the computer to start without requiring the power-on password, but the
keyboard and mouse are locked until you enter the password. The keyboard LEDs rotate constantly
when the computer is in locked mode.
To establish a power-on password through the Computer (F10) menu:
1.

Power on or restart the computer.

2.

As soon as the computer is powered on, press and hold F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.
If you do not press F10 at the appropriate time, you must restart the computer and then press and
hold F10 again to access the utility.
If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3.

Select Security>Power-On Password and then follow the onscreen instructions.

4.

Before exiting, select File>Save Changes and Exit.

Entering a power-on password
To enter a power-on password:
1.

Restart the computer.

2.

When the key icon appears on the monitor, enter the current password, and then press Enter.

Type carefully. For security reasons, the characters you enter do not appear on the screen.
If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you will enter the F10 setup screen with read-only permission. (See the Setup Browse Mode option
under the Power-On options.)
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Entering a setup password
If a setup password has been established on the computer, you will be prompted to enter it each time
you run the Computer Setup (F10) Utility.
To enter a setup password:
1.

Restart the computer.

2.

As soon as the computer is powered on, press and hold F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.
If you do not press F10 at the appropriate time, you must restart the computer and press and hold
F10 again to access the utility.
If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3.

When the key icon appears on the monitor, enter the setup password, and press Enter.

Type carefully. For security reasons, the characters you enter do not appear on the screen.
If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must restart the computer before you can continue.
Changing a power-on or setup password
To change a power-on or setup password:
1.

Restart the computer.

2.

To change the power-on password, go to step 4.

3.

To change the setup password, as soon as the computer is powered on, press and hold F10 until
you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
If you do not press F10 at the appropriate time, you must restart the computer, and then press and
hold the F10 key again to access the utility.
If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

4.

When the key icon appears, enter the current password, a slash (/) or alternative delimiter
character, the new password, another slash (/) or alternative delimiter character, and the new
password again as shown:
current password/new password/new password
For information about the alternative delimiter characters, see National keyboard delimiter
characters on page 49.
Type carefully. For security reasons, the characters you enter do not appear on the screen.

5.

Press Enter.

The new password takes effect the next time you power on the computer.
The power-on and setup passwords can also be changed using the Security options in the Computer
Setup (F10) Utility.
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Deleting a power-on or setup password
To delete a power-on or setup password:
1.

Power on or restart the computer.

2.

Choose from the following:
●

To delete the power-on password, go to step 4.

●

To delete the setup password, as soon as the computer is powered on, press and hold F10
until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if
necessary.
If you do not press F10 at the appropriate time, you must restart the computer and then press
and hold F10 again to access the utility.
Use the appropriate operating system shutdown process.

3.

When the key icon appears, enter the current password followed by a slash (/) or alternative
delimiter character: current password/.
For information about the alternative delimiter characters see National keyboard delimiter
characters on page 49.

4.

Press Enter.

National keyboard delimiter characters
Each keyboard meets country-specific requirements. The syntax and keys you use for changing or
deleting passwords depend on the keyboard included with the computer.
Table 4-3 National keyboard delimiter characters
Language

*
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Delimiter

Language

Delimiter

Language

Delimiter

Arabic

/

Greek

-

Russian

/

Belgian

=

Hebrew

.

Slovakian

-

BHCSY *

-

Hungarian

-

Spanish

-

Brazilian

/

Italian

-

Swedish/Finnish

/

Chinese

/

Japanese

/

Swiss

-

Czech

-

Korean

/

Taiwanese

/

Danish

-

Latin American

-

Thai

/

French

!

Norwegian

-

Turkish

.

French
Canadian

é

Polish

-

U.K. English

/

German

-

Portuguese

-

U.S. English

/

Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia
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Clearing passwords
If you forget the password, you cannot access the computer.
For instructions about clearing passwords, see Configuring password security and resetting
CMOS.

Chassis security
Side access panel sensor (Smart Cover Sensor) (optional)
The optional Side access panel sensor is a combination of hardware and software technology that can
alert you when the computer side access panel has been removed (if the sensor has been configured in
the Computer Setup (F10) Utility).
The three levels of Side access panel sensor protection are shown in the following table:
Table 4-4 Side access panel sensor protection levels

*

Level

Setting

Description

Level 0

Disabled

Side access panel sensor * is disabled (default).

Level 1

Notify User

When the computer restarts, a message appears indicating that the computer
side access panel has been removed.

Level 2

Setup Password

When the computer is restarted, a message appears indicating that the
computer side access panel has been removed. You must enter the setup
password to continue.

Side access panel sensor settings can be changed using the Computer Setup (F10) Utility.

Setting the side access panel sensor protection level
To set the side access panel sensor protection level:
1.

Power on or restart the computer.

2.

As soon as the computer is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the computer,
and then press and hold the F10 key again to access the Computer Setup (F10) Utility.
If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3.

Select Security>Smart Cover>Cover Removal Sensor, and follow the onscreen
instructions.

4.

Before exiting, select File>Save Changes and Exit.

Side access panel solenoid lock
The side access panel solenoid locks the side access panel to the chassis. The solenoid is controlled by
a local or remote signal.
To lock the solenoid, set a password for the solenoid lock in the Computer Setup (F10) Utility. To unlock
the solenoid, remove the solenoid lock password in the Computer Setup (F10) Utility.
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The solenoid lock FailSafe Key–available from HP–is is a device for manually disabling the solenoid
lock. You will need the FailSafe Key in case of forgotten password, power loss, or computer
malfunction.
Cable lock (optional)
To prevent theft, the rear chassis panel of the computer accommodates a keyed cable lock. This cable
lock attaches to the chassis and secures it to the work area.

Fault notification and recovery
Fault notification and recovery features combine innovative hardware and software technology to
prevent the loss of critical data and minimize unplanned downtime.
If the computer is connected to a network that is managed by HP CMS, the computer sends a fault
notice to the network management application. With HP CMS, you can also remotely schedule
diagnostics to run on managed PCs and create a summary report of failed tests.

Drive Protection System
The Drive Protection System (DPS) is a diagnostic tool built into hard disk drives and is installed in select
HP computers. The DPS helps diagnose problems that might result in unwarranted hard disk drive
replacement.
When HP computers are built, each installed hard disk drive is tested using the DPS, and a permanent
record of key information is written onto each drive. Every time the DPS is run, test results are written to
the hard disk drive. The service provider can use this information to help diagnose conditions that
required you to run the DPS software.

ECC fault prediction
When the computer encounters an excessive number of error checking and correcting (ECC) memory
errors, it displays a local alert message. This message contains information about the errant DIMM,
enabling you to take action before you experience noncorrectable memory errors. ECC DIMMs are
standard on this computer.

Thermal sensors
Several thermal sensors in the HP Workstation regulate computer fans to maintain an acceptable,
efficient chassis temperature.
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Dual-state power button
With ACPI enabled, the power button can function as an on/off switch or as a button. This feature does
not completely turn off power, but instead causes the computer to enter a low-power standby state. This
enables you to go to standby without closing applications, and to return to the same operational state
without any data loss.

Changing the power button configuration
To change the power button configuration:
1.

Select Start, and then select Control Panel>Power Options.

2.

In Power Options Properties, select the Advanced tab.

3.

In the Power Button section, select Hibernate.
NOTE: Hibernate must be enabled in the Hibernate tab.

After configuring the power button to function as a button, you can press the power button to put the
computer in a very low power state. Press the button again to bring the computer out of this low power
state to full power state. To completely turn off power to the computer, press and hold the power button
for four seconds.
CAUTION: Do not use the power button to power off the computer unless the system is not
responding; turning off the power without operating system interaction can cause data loss.
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Replacing components
This chapter presents removal and installation procedures for most internal workstation components. It
includes these topics:
Topics
Warnings and cautions on page 54
Service considerations on page 55
Customer Self-Repair on page 59
Removing and installing components on page 60
Product recycling on page 108
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Warnings and cautions
WARNING!
Any surface or area of the equipment marked with this symbol indicates the
presence of a hot surface or hot component. If this surface is contacted, the potential for injury exists.
To reduce the risk of injury from a hot component, enable the surface to cool before touching.
WARNING!
Any surface or area of the equipment marked with this symbol indicates the
presence of an electrical shock hazard. To reduce the risk of injury from electrical shock, do not open
any enclosed area marked with this symbol.
WARNING!

To reduce the risk of electric shock or damage to your equipment:

— Do not disable the power cord grounding plug. The grounding plug is an important safety feature.
— Plug the power cord in a grounded (earthed) outlet that is easily accessible at all times.
— Disconnect power from the equipment by unplugging the power cord from the electrical outlet.
WARNING! To reduce the risk of serious injury, read the Safety & Comfort Guide. It describes
proper computer setup, posture, health, and work habits for computer users, and provides important
electrical and mechanical safety information. This guide is located at http://www.hp.com/ergo.
WARNING!

If a product is shipped in packaging marked with this symbol,

, the product must

always be lifted by two persons to avoid personal injury due to product weight.
CAUTION: Static electricity can damage the electronic components of the computer. Before
beginning these procedures, be sure you discharge static electricity by briefly touching a grounded
metal object.
CAUTION: Observe the following cautions when removing or replacing a processor:
— Installing a processor incorrectly can damage the system board. Contact an HP authorized reseller
or service provider to install the processor. If you plan to install the processor yourself, read all of the
instructions carefully before you begin.
— Failure to follow the computer preparation instructions can result in an improperly installed
processor, causing extensive computer damage.
— Processor socket pins are delicate and bend easily. Use extreme care when placing the processor in
the socket.
CAUTION: To prevent damage to the computer, observe the following Electrostatic Discharge (ESD)
precautions while performing the system parts removal and replacement procedures:
— Work on a static-free mat.
— Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your
body to the ground.
— Create a common ground for the equipment you are working on by connecting the static-free mat,
static strap, and peripheral units to that piece of equipment.
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NOTE: HP accessories are for use in HP Workstation products. They have been extensively tested for
reliability and are manufactured to high quality standards.

Service considerations
Review the following service considerations before replacing system components.

Cautions, warnings and safety precautions
Review the cautions, warnings, and safety precautions before accessing the computer components.
Also, review the Safety and Regulatory Guide that came with the computer for more information.

ESD information
Generating static
The following table shows that different activities generate different amounts of static electricity through
electrostatic discharge (ESD). Static electricity increases as humidity decreases.
Relative humidity
Event

55%

40%

10%

Walking across carpet

7,500V

15,000V

35,000V

Walking across vinyl floor

3,000V

5,000V

12,000V

Motions of bench worker

400V

800V

6,000V

Removing bubble pack from
PCB

7,000V

20,000V

26,500V

5,000V

11,000V

21,000V

Packing PCBs in foam-lined box
CAUTION:
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Static electricity in the amount of 700 volts might degrade a product.
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Preventing ESD equipment damage
Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories:
●

Transport products in static-safe containers such as tubes, bags, or boxes, to avoid hand contact.

●

Protect electrostatic parts and assemblies with nonconductive or approved containers or
packaging.

●

Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.

●

Place items on a grounded surface before removing them from containers.

●

When handling or touching a sensitive component or assembly, ground yourself by touching the
chassis.

●

Avoid contact with pins, leads, or circuitry.

●

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
nonconductive foam.

Personal grounding methods and equipment
Use the following items to help prevent ESD damage:
●

Wrist straps—These are flexible straps with a maximum of one megohm ± 10% resistance in the
ground cords. To provide a proper ground, wear the strap against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
computer.

●

Heel straps, toe straps, and boot straps—These can be used at standing computers and
are compatible with most types of shoes or boots. On conductive floors or dissipative floor mats,
use them on both feet with a maximum of one megohm ± 10% resistance between the operator
and ground.

The following table shows protection levels available from static shielding materials.
Table 5-1 Static shielding
protection levels
Method

Voltage

Antistatic plastic

1,500V

Carbon-loaded plastic

7,500V

Metalized laminate

15,000V

This section provides guidelines to prevent ESD damage to equipment.
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Grounding the work area
To prevent static damage in the work area:
●

Cover the work surface with approved static-dissipative material. Use a wrist strap connected to
the work surface, and properly grounded tools and equipment.

●

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

●

Handle electrostatic-sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only in static-free work areas.

●

Disconnect power and input signals before inserting and removing connectors or test equipment.

●

Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

●

Keep work area free of nonconductive materials, such as plastic assembly aids and Styrofoam.

●

Use field service tools (such as cutters, screwdrivers, and vacuums) that are conductive.

Recommended ESD prevention materials and equipment
The recommended materials and equipment are:
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●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Conductive foam

●

Conductive tabletop computers with a ground cord of one megohm ± 10% resistance

●

Static-dissipative table or floor mats with a hard-tie to ground

●

Field service kits

●

Static awareness labels

●

Wrist straps and footwear straps providing one megohm ± 10% resistance

●

Material-handling packages

●

Conductive plastic bags

●

Conductive plastic tubes

●

Conductive tote boxes

●

Opaque shielding bags

●

Transparent metallized shielding bags

●

Transparent shielding tubes
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Tools and software requirements
The tools necessary for computer component removal and installation are:
●

Torx T-15 driver

●

Flat blade and cross-tip screwdrivers

●

Diagnostics software

Special handling of components
The components included in this section require special handling when servicing the computer.
WARNING! Do not use the front bezel as a handle or lifting point when lifting or moving the
computer. Lifting the computer from the front bezel, or lifting it incorrectly, could cause the computer to
fall, causing possible injury to you and damage to the computer. To properly and safely lift the
computer, lift from the bottom of the computer.

Cables and connectors
Handle cables with care to avoid damage. Apply only the tension required to seat or unseat cables
during insertion or removal from the connector. When possible, handle cables by the connector or pullstrap. In all cases, avoid bending or twisting the cables, and be sure that the cables are routed in such
a way that they cannot be caught or snagged by parts being removed or replaced.
When servicing the computer, be sure that cables are placed in their proper location during the
reassembly process. Improper cable placement can damage the computer.
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Hard drives
Hard drives are fragile, precision components. Avoid subjecting them to physical shock and vibration.
The following guidelines apply to all drives, including failed drives, replacement drives, and spares.
●

Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are mounted in the computer.

●

Avoid dropping hard drives from any height.

●

If you are inserting or removing a hard drive, power off the computer. Do not remove a hard drive
while the computer is powered on or in standby mode.

●

Before handling a drive, be sure that you discharge static electricity. While handling a drive,
avoid touching the connector. For more information about preventing electrostatic damage, see
ESD information on page 55.
To prevent possible ESD damage when the drive is installed, connect the drive power cable before
connecting the data cable. This discharges accumulated static electricity through the drive power
cable to the computer chassis.

●

When inserting a drive, do not use excessive force.

●

Avoid exposing a hard drive to liquids, temperature extremes, or products with magnetic fields
such as monitors or speakers.

Lithium coin cell battery
The battery included with the computer provides power to the real-time clock and has a lifetime of
about three years.
For instructions on battery removal and replacement, see Battery on page 93.
WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short the external contacts, dispose
of in water or fire, or expose the battery to temperatures higher than 60° Centigrade (140° Fahrenheit).
NOTE: Do not dispose of batteries, battery packs, and accumulators with general household waste.

Customer Self-Repair
Customer Self-Repair enables you to obtain replacement parts and install them on the computer. For
more information, see http://www.hp.com/go/selfrepair/.
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Removing and installing components
Component locations
The following illustration and table identify workstation system board components.
Figure 5-1 System board component locations
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Table 5-2 System board components ID
Item

1

2

Component

Item

Component

1

Rear chassis fan

13

Battery

2

CPU power

14

SATA ports

3

Solenoid hood lock

15

4

Chassis intrusion

5

Item

Component

25

PCIe2 x1

26

PCIe2 x16(4)

Clear CMOS button

27

PCIe2 x1

16

Crisis recovery jumper

28

PCIe2 x16

CPU socket

17

Front chassis fan

29

PCIe2 x8(4)

6

CPU fan

18

System speaker

30

Audio

7

Memory sockets

19

3rd internal USB

31

USB

8

Main Power

20

Password jumper

32

Network/USB

9

Front power button/LED

21

Serial

33

DP display port 2

10

Front USB

22

Parallel

34

DVI —I video

11

1st internal USB/DASH

23

Front audio

35

Keyboard/mouse

12

2nd internal USB

24

PCI 32/33

1

2

Blue SATA ports, namely SATA0 and SATA1, support SATA Gen3 (6 Gb). Note that SATA5 is the only eSATA compatible
port.
Intel integrated HD video is supported on some workstation models, depending on installed CPU. Most supported Intel Core
processors support Intel HD Graphics 2000. Intel Xeon processors with model designations that end in "---5" support Intel HD
Graphics P3000. In Windows 7, you can view the model of CPU installed in the workstation by selecting Start > Control
Panel > System .

For related system architecture information, see System board architecture on page 1.
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Predisassembly procedures
NOTE: Read the section at the beginning of this chapter on Warnings and cautions and the Safety
and Regulatory Guide that came with the workstation before servicing components.
Perform the following steps before servicing the workstation:
1.

Locate and clear a suitable work area.

2.

Close all open software applications.

3.

Remove all USB keys, diskettes, CDs, and DVDs from the workstation.

4.

Shut down the operating system.

5.

Power off the workstation and all peripheral devices connected to it.

6.

Remove or disengage security devices that prevent you from opening the workstation.

7.

Disconnect the power cord from the electrical outlet and then from the workstation.

8.

Disconnect peripheral device cables from the workstation.

9.

Gather the tools.

10. Service the workstation.
11. Restore power to the workstation when servicing is done.
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Disassembly order
For convenience, disassembly procedures should be followed in a particular order. Use the following
table to determine the sequence in which to access major workstation components.
Table 5-3 Workstation component installation
To install/replace...

Remove...

Then
remove...

Then
remove...

Battery, front bezel, hard drive,
memory, power supply, rear
system fan, side access panel
sensor, or solenoid lock

Chassis lock

Side access
panel

Processor

Chassis lock

Side access
panel

Heatsink

Expansion card (PCI/PCIe)

Chassis lock

Side access
panel

Expansion card
support

Front panel I/O assembly, optical
bay filler, optical drive, power
button assembly, or system
speaker

Chassis lock

Side access
panel

Front bezel

System board

Chassis lock

Side access
panel

Expansion card
support

Then
remove...

Then
remove...

Expansion card
slot cover

Expansion
cards or DIMMs

Heatsink

Removing the cable lock (optional)
If a cable lock is installed on the workstation, remove it before servicing the workstation.
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Unlock it and remove from the cable lock slot as shown in the following figure.
Figure 5-2 Removing the cable lock
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Side access panel
Before accessing the internal components of the workstation, you must remove the side access panel.
This section describes how to remove and install the side access panel.

Removing the side access panel
WARNING! Power off the workstation and disconnect the power cord from the electrical outlet
before you remove the workstation side access panel.
To remove the side access panel:
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove locks that are present such as a cable lock.

3.

Pull up on the handle (1), rotate the panel away from the chassis (2), then slide the front edge of
the cover about 1.3 cm (1/2 inch) toward the rear of the system to remove it (3), as shown in the
following figure.
Figure 5-3 Removing the side access panel

Installing the side access panel
To install the side access panel:
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1.

Align the front edge of the side panel with the slot on the front of the chassis.

2.

Rotate the back of the side panel down onto the chassis, then press firmly until the latch engages.
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Side access panel sensor (optional)
The side access panel sensor is a remote solenoid that detects when the side access panel is opened.
This section describes how to remove and install the sensor.

Removing the side access panel sensor
To remove the side access panel sensor:
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Disconnect the sensor cable from the in-line chassis cable as shown below (1).
Figure 5-4 Removing the side access panel sensor

4.

Slide the sensor back in its slot, push the sensor down, and then remove it from the chassis (2).

Installing the side access panel sensor
To replace the side access panel sensor, reverse the previous steps.
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Side access panel solenoid lock
The side access panel solenoid lock provides a method to lock the side access panel by means of a
local or remote signal-controlled solenoid.
This section describes how to remove and install the side access panel solenoid lock.

Removing the side access panel solenoid lock
To remove the side access panel solenoid lock:
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Disconnect the side access panel solenoid lock cable from the system board (1).

4.

Remove the two screws that fasten the solenoid lock to the chassis (2) as shown in the following
figure.

5.

Pull the solenoid lock assembly inward and then up (3) to remove the assembly from the chassis.
Figure 5-5 Removing the side access panel solenoid lock

Installing the side access panel solenoid lock
Reverse the above steps to install the side access panel solenoid lock. This involves connecting the
solenoid lock cable to the system board and fastening the solenoid lock to the chassis.
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Bezel
This section describes how to remove and install the front chassis bezel.

Removing the front bezel
To remove the front bezel:
1.

Remove the side access panel (see Removing the side access panel on page 65).

2.

Lift the release tabs (1), and then rotate the front bezel off the chassis (2).
Figure 5-6 Removing the front bezel

Installing the front bezel
To install the front bezel, align the tabs discussed in the previous section and rotate the bezel until it
snaps in place.

Front panel I/O device assembly
This section describes how to remove and install a front panel I/O device assembly.

Removing the front panel I/O device assembly
To remove the front panel I/O device assembly:
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1.

Disconnect power from the workstation (see Predisassembly procedures on page 62 ).

2.

Remove the side access panel (see Removing the side access panel on page 65).
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3.

Remove the front bezel (see Removing the front bezel on page 68).

4.

Remove the fastening screws from the I/O device assembly and remove it from the chassis as
shown in the following figure.
Figure 5-7 Removing the front panel I/O device assembly

5.

Disconnect the front panel I/O device assembly cables from the system board as shown below.
Figure 5-8 Disconnecting the front panel I/O cables

6.
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Carefully guide the front panel I/O device assembly from the chassis.
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Installing the front panel I/O device assembly
To instal the front panel I/O device assembly:
1.

Guide the front panel I/O device assembly cables through the chassis openings from which they
were removed.

2.

Place the front panel I/O device assembly in the chassis, and then install the fastening screws in
reverse order as they were removed.

3.

Connect the front panel I/O audio (1), USB (2) cables, and power switch/LED cable (3) to the
system board as shown in the following diagram.
Figure 5-9 Connecting the front panel I/O device cables

NOTE: The front panel I/O device assembly also has a 1394a cable. This cable can be
connected to an optional 1394 expansion card or clipped to the bottom of the chassis with the
plastic clip provided.
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Optical disk drive (mini-tower configuration)
This section describes how to remove and install an optical disk drive in the workstation mini-tower
configuration. For instructions on how to remove and install an optical disk drive in the workstation
desktop configuration, see Optical disk drive (desktop configuration) on page 75.

Removing an optical disk drive from the optical bay (mini-tower
configuration)
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Remove the front bezel (see Removing the front bezel on page 68).

4.

Disconnect the data (1) and power (2) cables from the optical disk drive as shown in the following
figure.
Figure 5-10 Disconnecting optical disk drive cables
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5.

Lift the green drive lock release lever (1) and gently slide the drive out of the chassis (2) as shown
in the following figure.
Figure 5-11 Removing the optical disk drive
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Installing an optical disk drive in the optical bay (mini-tower configuration)
To install an optical disk drive:
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Remove the front bezel (see Removing the front bezel on page 68).

4.

If necessary, remove the EMI filter panel from the drive bay you wish to use.

5.

Lift the green release lever (1) and slide the optical disk drive into the bay (2) until it is stopped by
the release latch, as shown in the figure below.
Figure 5-12 Installing the optical disk drive

6.

Release the latch and continue sliding the drive until the latch closes and engages the drive.
TIP: Adjacent drives may move slightly when you insert the drive. If necessary, slide and align
other devices to get the release latch to close and engage all devices.
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7.

Connect the power cable (1) and data cables (2) to the drive as shown in the following figure.
Figure 5-13 Connecting power and data cables

8.

Connect the optical disk drive data cable to the appropriate SATA port on the system board as
shown in the following figures.
NOTE: HP recommends using SATA ports 3 and 4 for optical disk drives, SATA ports 0 and 1
for primary hard disk drives, and port 5 only after all other ports have been used. (Refer to the
service label on the side access panel of your workstation to determine the location of the SATA
ports. These ports are also shown in Figure 5–1.)
NOTE: Blue SATA ports (SATA0 and SATA1) support SATA Gen3 (6 Gbit). Only SATA5 is
eSATA compatible.
Figure 5-14 Connecting power and data cables
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Optical disk drive (desktop configuration)
This section describes how to remove and install an optical disk drive in the workstation desktop
configuration. For instructions on removing and installing optical disk drives in the workstation minitower configuration, see Optical disk drive (mini-tower configuration) on page 71.

Removing an optical drive (desktop configuration)
1.

Disconnect power from the system (see Predisassembly procedures on page 62),

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Remove the front bezel (see Removing the front bezel on page 68).

4.

Disconnect the data (1) and power (2) cables from the drive, as shown in the following figure.
(The connector colors might be different than shown in the following figure.)
Figure 5-15 Disconnecting the optical drive cables
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5.

Press down on the green drive-lock release lever (1) and gently slide the drive out of the chassis
(2).
Figure 5-16 Removing the optical drive from chassis

6.

If you plan to install another drive, remove the drive completely from the chassis (1) and remove
the four guide screws from the drive (2) so that you can re-use the screws to install the new drive.
(See Installing an optical drive (desktop configuration) on page 77 below.)
Figure 5-17 Removing the optical drive screws
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Installing an optical drive (desktop configuration)
1.

Disconnect power from the system (see Predisassembly procedures on page 62),

2.

Remove the side access panel (see Removing the side access panel on page 65),

3.

Remove the front bezel (see Removing the front bezel on page 68),

4.

Remove the bezel blank from the drive bay you wish to use.

5.

Remove the EMI filter panel from the drive bay you wish to use.

6.

Install the four black metric M3 guide screws into the drive (1).
Figure 5-18 Installing the optical drive

7.

Align the screws with the grooves in the drive bay and gently slide the drive into the casing until it
snaps into place (2).
CAUTION: Pull on the drive to make sure it has snapped into place. If the drive is loose, it can
be damaged if you move the workstation.
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8.

Connect the data (1) and power (2) cables to the drive and system board.
Figure 5-19 Connecting data and power cables
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Speaker
This section describes how to remove and install the speaker.

Removing the speaker
To remove the speaker:
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Remove the front bezel (see Removing the front bezel on page 68).

4.

Disconnect the speaker cable from the system board (1) as shown in the figure below.

5.

Remove the two screws as shown (2).

6.

Slide the speaker away from the chassis and remove it from the chassis (3).
Figure 5-20 Removing the workstation speaker

Installing the speaker
To install the speaker, reverse the previous steps.
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Power supply
This section describes how to remove and install a power supply.

Removing the power supply
To remove the power supply:
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Disconnect all of the power supply cables from the system board and all peripheral devices (hard
drives, optical drives, and others as needed).

4.

Remove the four screws from the rear of the chassis (1).

5.

Slide the power supply inward then up to remove it from the chassis (2).
Figure 5-21 Removing power supply

Installing the power supply
To install the power supply, reverse the previous steps.
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Power connections
For help with identifying power cables, see the following figure and table. Ensure that all cables are
routed or tied so they cannot interfere with the processor heatsink fans.
Figure 5-22 Power connections

Table 5-4 Power connector description
Connector

Description

Item

Description

P1

Main power

P12

Optical disk drive

P3

CPU power

P13

Optical disk drive

Hard disk drives

P14

4–pin molex connector for
legacy devices

P8, P9, P10
P6
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Rear system fan assembly
This section describes how to remove and install the rear system fan assembly.

Removing the rear system fan assembly
To remove the rear system fan assembly:
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Disconnect the rear system fan assembly cable (1) from the system board as shown in the
following figure.
Figure 5-23 Disconnecting fan wires

4.

Remove the four screws from the rear of the chassis (2), and then pull the fan assembly inward
and then up (3) out of the chassis.

Installing the rear system fan assembly
To install the rear system fan assembly, reverse these steps.
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Memory
This section presents memory module (DIMM) configuration information and removal/installation
procedures.

Supported DIMM configurations
The workstation supports these DIMM configurations:
●

Four DIMM slots

●

Memory configuration from 1 GB to 32 GB

●

No support for mirroring

●

No support for DIMM sparing

●

Error checking and correcting (ECC) and non-ECC DIMMs are supported.

DIMM installation guidelines
●

Install only HP-approved DDR3 DIMMs.
CAUTION: HP ships only DIMMs that are electrically and thermally compatible with this
workstation. Because third-party DIMMs might not be electrically or thermally compatible, they are
not supported by HP.

●

For ECC DIMMs, use only industry-standard ECC unbuffered DIMMs. See http://www.hp.com/
go/quickspecs to find which DIMMs are compatible with the workstation.

●

Do not intermix non-ECC memory DIMMs with ECC memory DIMMs.

DIMM installation order
Review the following to determine the correct installation order for DIMMs.
Figure 5-24 DIMM load order
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BIOS errors and warnings
The BIOS generates warnings/errors on invalid memory configurations:
●

If the BIOS can find a valid memory configuration by disabling plugged-in memory, it does so and
reports a warning during POST. The workstation can still be started. The warning will indicate the
location of the failed DIMM on the system board or memory riser.

●

If there is no way for the BIOS to obtain a valid memory configuration by disabling plugged-in
memory, the BIOS halts with a diagnostics code for memory error (five beeps and blinks).

Removing a DIMM
To remove a DIMM:
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).
CAUTION: To prevent possible electrical damage to the DIMMs, power off the workstation and
unplug the power cord from the AC power outlet before removing or installing memory. The
workstation will not recognize the memory changes if the DIMM is damaged.

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Push gently outward on the DIMM socket levers (1) as shown in the following figure.
Figure 5-25 Removing a DIMM

4.
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Lift the DIMM straight up (2) and out of the socket, then store the DIMM in an antistatic bag.
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Installing a DIMM
To install the DIMM:
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).
CAUTION: To prevent possible electrical damage to the DIMMs, power off the workstation and
unplug the power cord from the AC power outlet before removing or installing memory. The
workstation will not recognize the memory changes if the DIMM is damaged.

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Push gently outward on the DIMM socket levers as shown in the following figure.
Figure 5-26 Opening DIMM socket levers
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4.

Align the DIMM connector key with the DIMM socket key, and then seat the DIMM firmly in the
socket (1) as shown in the following figure.
CAUTION: DIMMs and their sockets are keyed for proper installation. To prevent socket or
DIMM damage, align these guides properly when installing DIMMs.
Figure 5-27 Seating the DIMM

5.
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Secure the socket levers (2).
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Expansion card slot identification
This section identifies and describes workstation expansion card slots, and presents card configuration
information.

Slot identification and description
The following figure identifies workstation expansion card slots.
Figure 5-28 Identifying expansion card slots

The following table describes the workstation PCIe card slots.
Table 5-5 PCI slots
Slot

Type

Slot power
(per slot)

1

PCIe2 - x8(4)

25W

2

PCIe2 - x16

75W

3

PCIe2 - x1

10W

4

PCIe2 - x16(4)

25W

5

PCIe2 - x1

10W

6

PCI 32b/33MHZ

25W

7

PCI 32b/33MHZ

25W

Slot power
(maximum)

150W max for
total power
usage of all
card slots

NOTE: The x1, x4, and x16 designators describe the mechanical length of the slot. The number in
parentheses lists the number of electrical PCIe lanes routed to the expansion slot. For example, x16(4)
means that the expansion slot is mechanically a x16 length connector, with four PCIe lanes connected.
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NOTE: Graphics cards greater than 75 watts require the use of an auxiliary power cable adapter.
See Power connections on page 81 for more information.
NOTE: Slots two and four use latches to secure the card in the slot.

Power limitations for graphics cards
CAUTION: To prevent damage, the overall power consumption of the workstation (including I/O
cards, CPU, and memory) must not exceed the maximum rating of the workstation power supply.
When planning, purchasing, and installing graphics cards in your workstation, observe the following
power limitations:
●

Maximum allowable graphics card power for Slot 2 is 150W. Note that 75W is available from
the system board and an additional 75W directly from the PSU (using the 6–pin power connector
from the power supply). If a second graphics card is installed in Slot 4, the combined power
consumption of both cards must not exceed 150W.
NOTE: If you use a graphics card with greater than 75 watts of power, leave the adjacent slot
empty for thermal cooling considerations.

●
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Slot 4 supplies 25W of power. Do not exceed this power limitation when installing a second
graphics card in this slot.
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Choosing an expansion card slot
Whenever possible, use the following tips to help you select the proper slot for an expansion card:
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●

Insert the primary graphics card in a PCIe x16 slot intended for graphics.

●

Insert a second graphics card in a second PCIe x16 slot intended for a secondary graphics card.

●

Install full-length cards in slots that support full-length cards.

●

For optimal cooling and acoustics, place a lower-profile card next to the CPU heatsink.

●

Whenever possible, avoid placing cards so they block the graphics card heatsink and fan. This is
especially important for graphics cards that require attaching the auxiliary power cable.

●

Install a card in a slot that most closely matches its interface technology:
◦

Install a PCIe Gen2 x16 or a PCIe Gen2 x8 card in the PCIe Gen2 x16 slot.

◦

Install a PCIe Gen1 x16 or a PCIe Gen1 x8 card in the PCIe Gen1 x16 slot.

◦

Install a PCIe Gen1 x4 card in the PCIe Gen1 x4 slot.

◦

Install a PCIe Gen1 x1 card in the PCIe Gen1 x1 slot.

◦

Install a PCI card in one of the PCI slots.

◦

Whenever possible, install a PCIe x1 card in an x1 slot.

●

Leave as much space as possible between cards.

●

For best operational efficiency, select a slot that:
◦

Electrically matches the number of PCIe card lanes (e.g., x4 in a x4 slot).

◦

Has more lanes electrically.

◦

Has fewer lanes, but is closer to your needs. For example, place an x16 card in an x4 slot,
and an x4 card in an x1 slot.

●

An x1 connector supports an x1 card only. Although an x1 card can be inserted into any slot, this
may waste the potential for future card placement.

●

Install cards that require internal cable connections so that the cables are organized and have the
least amount of strain on them. Some cables may be routed under, rather than over the other
expansion cards.

●

To prevent electromagnetic interference, avoid installing a card with external cable connections
next to a graphics card.
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Expansion card
PCIe I/O slots may supply less bus bandwidth than what is physically defined for the slot.

Expansion card slot description
NOTE: The x1, x4, and x16 designators describe the mechanical length of the slot. The number in
parentheses lists the number of electrical PCIe lanes routed to the expansion slot. For example, x16(4)
means that the expansion slot is mechanically a x16 length connector, with four PCIe lanes connected.
Use the following table to determine PCIe card compatibility.
Table 5-6 HP x210 CMT Workstation PCIe compatibility matrix
Slot

Mechanical compatibility

Electrical lanes available

1

x8 connector

4

2

x16 connector

16

3

x1 connector

1

4

x16 connector

4

5

x1 connector

1

Removing an expansion card
To remove an expansion card:
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1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).
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3.

Remove the expansion card retainer (if installed): grasp the top of the clamp (1), squeeze the
release handles until the bottom of the clamp releases from the clamp rail (2) (it should click when
it releases), and swing the clamp out from the back panel (3).
Figure 5-29 Removing expansion card retainer

4.

Remove all cables connected to the expansion card.

5.

Push down on the expansion card retention clamp levers on the inside of the chassis to open the
retention clamp (1) as shown below.
Figure 5-30 Removing the expansion card

6.
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If the card is in one of the slots with a latch, release the latch (2). (Note that there are two different
styles of latch.)

Removing and installing components

91

7.

Carefully lift the card from the chassis (3).

8.

If you are not replacing the card in this slot, install an expansion slot cover and close the
expansion card retention clamp.
If the expansion card retention clamp does not close, ensure that all cards are properly seated,
and then try again.

Installing an expansion card
Visit http://www.hp.com/go/quickspecs to learn which graphics cards are supported in the
workstation, how much memory each graphics card includes, and graphics card power requirements.
To install an expansion card:
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Push the expansion card retention clamp levers down on the outside of the chassis to release the
retention clamp (1) as shown in the figure below.
Figure 5-31 Removing the slot cover

4.

Remove the expansion card slot cover by pulling it up, out of the chassis (2).
TIP: Grasp the slot cover between two fingers—one from the inside of the chassis, and one from
the outside.

5.

92

Angle the card into the expansion card guide.
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6.

Align the PCIe card keyway with the slot key, and then firmly seat the card in the slot as shown
(3).

7.

Close the expansion card retention clamp by rotating it downward (4).
●

If the PCI retention clamp does not close, ensure that all cards are properly seated, and then
try again.

●

If required by the card, connect the auxiliary power cable to the card (not illustrated).

Battery
This section describes how to remove and install the battery.
The battery that comes with the workstation provides power to the real-time clock and has a minimum
lifetime of about three years.
WARNING! This workstation includes a lithium battery. There is a risk of fire and chemical burn if
the battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose
of in water or fire, or expose battery to temperatures higher than 60°C (140°F).
CAUTION: Before removing the battery, back up the CMOS settings in case they are lost when the
battery is removed. To back up the CMOS settings, select the Save to Diskette option in the
Computer Setup (F10) Utility.
NOTE: Do not dispose of batteries, battery packs, or accumulators with general household waste.

Removing the battery
To remove the battery:
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1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Locate the battery on the system board.
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4.

Push horizontally on the battery (1) with a small screwdriver and it will pop out of its holder (2) as
shown in the following figure.
Figure 5-32 Removing the battery

Installing the battery
To install the battery:
1.

Confirm the polarity (positive or negative) of the battery to position it correctly in the battery
holder.

2.

Place the battery edge under the plastic housing tab and press gently until it snaps into place.

Hard disk drive
This section provides information to successfully remove and install a hard disk drive.

Removing the hard disk drive
To remove a hard disk drive:
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1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Disconnect the power and data cables from the drive (1).
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4.

Squeeze together at the HDD sled's green touch points (2), then slide the hard disk drive (3) out
from the chassis as shown. Support the HDD from below while you slide it out.
Figure 5-33 Removing the drive from the chassis

5.

Replace the side access cover when finished.

Installing hard disk drives
Installation guidelines
The workstation typically ships with one HDD, but you can add additional drives to expand space for
programs, data storage, or backup. In general, you should plan to add HDDs starting with the first
available bay farthest from the optical drive bays.
After installation, you can use the Computer Setup (F10) Utility to:
●

Assign drive letters of your choice to the new HDDs. (The workstation assigns drive letters
automatically if you do not choose them.)

●

Change the boot sequence so that the workstation boots from one of the additional drives. (Disk
C:\ is the typical boot disk.)

See The Computer Setup (F10) Utility on page 25 for more information.
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Installation
To install an HDD:
1.

Select a drive bay in which to install the hard disk drive and remove its mounting sled.
Figure 5-34 HDD installation order

Figure 5-35 Removing the mounting sled
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2.

Install the HDD into the mounting sled as shown in the following figure.
Figure 5-36 Installing the HDD in the mounting sled

3.

Push the sled containing the HDD into the selected bay until it snaps into place (1) as shown in the
following figure.
Figure 5-37 Installing the HDD drive

4.

Attach a power cable (2) and a data cable (3) to the hard disk drive.
CAUTION: To avoid crushing or pinching the data cable when you replace the access panel,
use the HP-supplied data cable with right-angle connectors.
NOTE: Connect data cables to lower-numbered drive connectors first on the system board. To
identify hard disk drive ports, refer to the workstation service label on the side access panel.
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NOTE: Blue SATA ports (numbered zero and one) support SATA Gen 3 (6 Gbit/sec).
5.

Replace all components that were removed in preparation for component installation.

CPU heatsink
This section describes how to remove and install a CPU heatsink.

Removing the CPU heatsink
To remove a heatsink:
1.

Power down the workstation (see Predisassembly procedures on page 62).

2.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

3.

Remove the side access panel (see Removing the side access panel on page 65).

4.

Slowly and evenly loosen one pair of diagonally opposite screws (1) from the CPU until the screw
shanks disengage from the system board, and then loosen the remaining pair (2) as shown below.
CAUTION: Do not fully loosen one screw, and then move on to the next. Instead, loosen all
screws a little at a time, ensuring that the CPU remains level.
Figure 5-38 Loosening heatsink screws in sequence
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5.

Disconnect the CPU heatsink fan cable from the system board (1) as shown in the following figure.
Figure 5-39 Disconnecting the heatsink fan cable

6.

Before lifting the heatsink, gently twist the heatsink to break the thermal compound between the
CPU and the heatsink.

7.

Lift the CPU heatsink out of the chassis (2).

8.

Use alcohol and a soft cloth to clean the thermal interface residue from the CPU and the heatsink.
Allow the alcohol on the CPU and CPU heatsink to dry completely.

Installing the CPU heatsink
To install a heatsink:
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1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Remove the CPU heatsink (see Removing the CPU heatsink on page 98).

4.

Perform one of the following tasks:
●

If you are reusing the original heatsink, apply thermal compound to the center of the CPU top
surface.

●

If you are using a new CPU heatsink, do not apply thermal compound to the CPU because
the new heatsink already has thermal compound applied to the heatsink surface. Instead,
remove the thermal compound protective liner from the bottom of the new heatsink.

5.

Align the heat sink's four mounting screws with the mounting holes in the chassis.

6.

Carefully place the heatsink on the CPU.

7.

Tighten each heatsink screw a little at a time to ensure that the CPU stays level. Do not fully tighten
one screw and then move on to the next.

Removing and installing components

99

8.

Tighten each set of diagonally opposed screws a little at a time to 6 in-lbs of torque.
CAUTION: Do not overtighten the heatsink screws. Overtightening can strip the threads in the
chassis.

9.

Connect the CPU heatsink fan connector to the system board.
Figure 5-40 Connecting the heatsink fan cable
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CPU
This section describes how to remove and install a CPU.

Removing a CPU
To remove a CPU:
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Remove the CPU heatsink (see Removing the CPU heatsink on page 98).

4.

Raise the CPU socket lever (1) and open the cover (2) as shown in the following figure.
Figure 5-41 Removing a CPU

CAUTION: Do not touch the CPU socket contacts or the gold pads underneath the CPU. Use
extreme care and handle the CPU only by the edges.
5.
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Pull the CPU straight out of the socket (3). Store the CPU in a static free container in a safe place
where it cannot be damaged.
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Installing a CPU
NOTE: HP recommends that you do not swap processors (CPUs) from one system board to another.
To install a CPU:
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Remove the CPU heatsink (see Removing the CPU heatsink on page 98).

4.

Remove the CPU (see Removing a CPU on page 101).

5.

Using extreme care, fully raise the CPU socket lever and cover.
CAUTION: The CPU socket contacts are delicate. To avoid bending the contacts, use extreme
care when installing the CPU in the socket.

6.

Align the notches in the CPU base with the tabs on the socket as shown in the figure below.
Seat the CPU into the socket. Ensure that the underside of the CPU is level with the top of the CPU
socket.
Figure 5-42 Seating the CPU
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7.

The CPU cover plate has two tangs opposite its hinge. The tangs slip beneath the mounting screw
on the systemboard as the CPU cover plate hinges downward over the CPU. Close the CPU cover
plate by closing the socket lever, latching the lever securely into the locking notch on the cover
plate.

8.

Replace the CPU heatsink (see Installing the CPU heatsink on page 99), and then close the side
access cover.
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System board
This section describes replacing the system board.

Removing the system board
To remove the system board:
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Remove expansion boards and graphics cards (see Removing an expansion card on page 90).

4.

Remove the CPU heatsink (see Removing the CPU heatsink on page 98). Note that the CPU
heatsink screws also secure the system board to the chassis.

5.

Disconnect all cabling from the system board.
TIP: Make a note of the cable connections before disconnecting them from the system board.
For more information, refer to Power connections on page 81.

6.

Remove the ten mounting screws (1) as shown in the following figure.
Figure 5-43 Removing the system board
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7.

Lift the system board slightly, and pull the board away from the rear of the chassis.

8.

Lift the system board upward out of the chassis (2).
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Installing the system board
To install the system board:
1.

Carefully insert the system board into the chassis so that mounting holes align with the screw holes
in the chassis (2). You may have to slide the system board toward the rear of the chassis.
Figure 5-44 Inserting and aligning the system board

104

2.

Replace the mounting screws (2).

3.

Reinstall all removed components and cables. (See Power connections on page 81 to identify
power cables.)
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Converting to desktop configuration
This workstation can be operated in the mini-tower or the desktop configuration. Follow these steps to
convert to desktop configuration operation:
1.

Disconnect power from the workstation (see Predisassembly procedures on page 62).

2.

Remove the side access panel (see Removing the side access panel on page 65).

3.

Remove the front bezel from the workstation (see Removing the front bezel on page 68).

4.

Press gently on the edges of the optical drive bay filler panel (1) to remove it from the front bezel
as shown in the following figure.
Figure 5-45 Removing the ODD bay filler panel

5.

ENWW

Rotate the filler panel (2) 90 degrees to a horizontal position.
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6.

Align the slots in the filler panel frame with the tabs in the front bezel. Press the optical drive filler
panel back into the front bezel until it snaps into place as shown in the following figure.
Figure 5-46 Installing the ODD bay filler panel
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7.

On the back of the front bezel, squeeze the HP logo mounting tabs (1) and press the logo outward
(2) as shown in the following figure.
Figure 5-47 Rotating the HP logo

Rotate the HP logo 90 degrees counterclockwise, and then release the logo and press it back into
place in the front bezel.
8.
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Remove the EMI filler panels and remove the optical disk drive from the chassis (see Removing an
optical disk drive from the optical bay (mini-tower configuration) on page 71.
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9.

Rotate the EMI filler panels and the optical drive 90 degrees as shown in the figure below, and
then reinstall them (see Installing an optical drive (desktop configuration) on page 77.
Figure 5-48 Reinstalling the optical drive

10. Replace the front bezel (see Installing the front bezel on page 68) and the side access panel (see
Installing the side access panel on page 65) when finished.

Product recycling
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries.
For information about recycling HP components or products, see http://www.hp.com/go/recycle.
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6

Diagnostics and troubleshooting
This chapter describes the tools available for diagnosing and troubleshooting system issues, and
includes these topics:
Topics
Calling technical support on page 110
Locating ID labels on page 110
Locating warranty information on page 111
Diagnosis guidelines on page 112
Troubleshooting checklist on page 114
HP troubleshooting resources and tools on page 115
Troubleshooting scenarios and solutions on page 117
Self-troubleshooting with HP Vision Diagnostics on page 126
Diagnostic codes and errors on page 135
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Calling technical support
At times you might encounter an issue that requires technical support. When you call technical support:
●

Have the computer readily accessible.

●

Write down the computer serial numbers, product numbers, model names, and model numbers
and have them in front of you.

●

Note any applicable error messages.

●

Note any add-on options.

●

Note the operating system.

●

Note any third-party hardware or software.

●

Note the details of any blinking LEDs on the front of the computer.

●

Note the applications you were using when you encountered the problem.

NOTE: When calling in for service or support, you might be asked for the Product Number (example:
PS988AV) of the computer. If the computer has a Product Number, it is generally located next to the
10- or 12-digit Serial Number of the computer.
NOTE: On most models, the serial number and product number labels can be found on the top panel
or side of the computer and at the rear of the computer.
For a listing of all worldwide technical support phone numbers, visit http://www.hp.com/support,
select your region, and click Contact HP in the upper-left corner.

Locating ID labels
To assist in troubleshooting, product, serial, and authentication numbers are available on each
computer.
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Each HP Workstation has two unique serial number labels (1) and a Certificate of Authentication
(COA) label (2) as shown in the figure below.
Figure 6-1 Workstation label locations

In general, the serial number labels can be found on the top panel or on the side of the computer and
at the rear of the computer (your computer may look different). Keep this number available when
contacting customer service for assistance.
A product number is generally located next to the serial number.
The COA is used for Windows-preinstalled systems only, and is generally located on the top panel or
side of the computer near the serial number label. On some computers it is located on the bottom of the
computer.

Locating warranty information
To locate base warranty information, see http://www.hp.com/support/warranty-lookuptool.
To locate an existing Care Pack, see http://www.hp.com/go/lookuptool.
To extend a standard product warranty, visit http://www.hp.com/hps/carepack. HP Care Pack
Services offer upgraded service levels to extend and expand a standard product warranty.
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Diagnosis guidelines
If you encounter a problem with the computer, monitor, or software, the following sections provide a list
of general suggestions that help you isolate and focus on the problem before taking further action.

Diagnosis at startup
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●

Verify that the computer and monitor are plugged into a working electrical outlet.

●

Remove all diskettes, CDs, or USB drive keys from your system before turning it on.

●

Verify that the computer is turned on and the green power light is on.

●

If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

●

Verify that the monitor is turned on and the green monitor light is on. Note that not all monitors are
equipped with LED lights to indicate their functionality.

●

Turn up the brightness and contrast controls of the monitor if the monitor is dim.

●

If the computer has multiple video sources and only a single monitor, the monitor must be
connected to the primary display adapter. During startup, the other monitor connectors are
disabled; if the monitor is connected to one of these ports, it will not function after Power-on Self
Test (POST). You can select the default source in Computer Setup (F10).
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Diagnosis during operation
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●

Look for blinking LEDs on the front of the computer. The blinking lights are error codes that will
help you diagnose the problem. Refer to the Diagnostic LED and audible (beep) codes
on page 135 section of this document for information on interpreting diagnostic lights and
audible codes.

●

Press and hold any key. If the system beeps, then your keyboard is operating correctly.

●

Check all cables for loose or incorrect connections.

●

Wake the computer by pressing any key on the keyboard or the power button. If the system
remains in suspend mode, shut down the system by pressing and holding the power button for at
least four seconds, then press the power button again to restart the system. If the system does not
shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart,
press the power button to start the computer.

●

Reconfigure the computer after installing a non–plug and play expansion board or other option.

●

Be sure that all required device drivers have been installed. For example, if you have connected a
printer, you must install a printer driver.

●

If you are working on a network, plug another computer with a different cable into the network
connection. There might be a problem with the network plug or cable.

●

If you recently added new hardware, remove the hardware and verify if the computer functions
properly.

●

If you recently installed new software, uninstall the software and verify if the computer functions
properly.

●

If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Alternatively, replace the monitor with a monitor that you know is working properly.

●

Upgrade the BIOS. A new release of the BIOS might have been released that supports new
features or fixes your problem.
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Troubleshooting checklist
Before running diagnostic utilities, use the following checklist to find possible solutions for computer or
software problems.
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●

Is the computer and monitor connected to a working electrical outlet?

●

Is the computer powered on?

●

Is the blue power light illuminated?

●

Is the monitor on?

●

Is the monitor power LED illuminated?

●

If the monitor is dim, adjust the monitor brightness and contrast controls.

●

Press and hold any key. If the system beeps, the keyboard is operating correctly.

●

Check cables for loose or improper connections.

●

After installing a non-plug and play (PnP) expansion board or other option (such as a diskette
drive), reconfigure the computer.

●

Are all necessary device drivers installed?

●

Have all printer drivers been installed for each application?

●

Have you removed diskettes, optical disks, and USB drive keys from the drives before powering
on the computer?

●

Are you running the latest version of BIOS, drivers, and software?
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HP troubleshooting resources and tools
This section provides information on the HP Help and Support Center, E-support, and Helpful Hints for
troubleshooting.

HP Support Assistant
The HP Support Assistant is a customized HP user interface that enhances the Windows 7 Help and
Support Center functions. This customized utility allows you to access specific information about an HP
Workstation such as configuration information by clicking Start > All Programs > HP. The interface
also provides customized help and support links to the HP Web site related to the HP Workstation.
NOTE: The customized HP Support Assistant is not available on Linux.

HP Performance Advisor
The HP Performance Advisor is an HP tool that offers a quick and easy way to configure and update HP
workstations. It improves workstation stability and performance while helping you work faster and more
productively. To use this tool, select Start > All Programs > HP > HP Performance Advisor.

E-support
Online access and support resources include Web-based troubleshooting tools, technical knowledge
databases, driver and patch downloads, online communities, and product change notification services.
The following Web sites are also available to you:
●

http://www.hp.com—Provides useful product information.

●

http://www.hp.com/support/workstation_manuals—Provides the latest online documentation.

●

http://www.hp.com/go/workstationsupport—Provides technical support information for
workstations.

●

http://www.hp.com/support—Provides a listing of the worldwide technical support phone
numbers. Access the telephone numbers by visiting the Web site, then select your region, and click
Contact HP in the upper-left corner.

●

http://www.hp.com/support/workstation_swdrivers—Provides access to software and drivers for
workstations.

Troubleshooting a problem
To help you troubleshoot problems with your system, HP provides the Business Support Center (BSC).
The BSC is a portal to an extensive selection of online tools. To access BSC and troubleshoot a problem
with the workstation, complete the following:
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1.

Visit http://www.hp.com/go/workstationsupport.

2.

Under the Business Support Center menu on the left, select Troubleshoot a problem.

HP troubleshooting resources and tools
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3.

Under Select your product (center window), select Workstations (under personal
computing).

4.

Under Select your product, continue with selections as appropriate to the workstation series
and model, and to the problem you are troubleshooting.

Instant Support and Active Chat
HP Instant Support is a set of Web-based support tools that automate and speed up the resolution of
desktop computing, tape storage, and printing problems.
Active Chat enables you to electronically submit a support ticket to HP over the Web. When you submit
a support ticket, Active Chat collects information about the computer and passes it to an online support
specialist. The collection of information might take up to 30 seconds depending on the computer
configuration. When you submit a support ticket, you receive a confirmation message containing your
case ID, the support hours for your location, and the estimated time of response.
For more information about HP Instant Support and Active Chat and how to use them, visit
http://www.hp.com/hps/hardware/hw_professional.html.
NOTE: This feature is not available on Linux.

Helpful hints
If you encounter a problem with the workstation, monitor, or software, the following provides a list of
general suggestions that help you isolate and focus on the problem before taking further action.
At startup
●

Verify that the workstation and monitor are plugged into a working electrical outlet.

●

Remove all diskettes, optical disks, and USB drive keys from the drives before powering on the
workstation.

●

Verify that the workstation is turned on and the blue power light is on.

●

If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

●

Verify that the monitor is turned on and the power LED is illuminated.

●

Turn up the brightness and contrast controls of the monitor if the monitor is dim.

●

If the workstation has multiple video sources and only a single monitor, the monitor must be
connected to the source selected as the primary video adapter. During startup, the other monitor
connectors are disabled; if the monitor is connected to one of these ports, it will not function after
Power-on Self Test (POST). You can select the default video source in Computer Setup (F10).

During operation
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●

Look for blinking LEDs on the front of the workstation. The blinking lights are error codes that will
help you diagnose the problem. Refer to the Diagnostic lights and audible (beep) codes section of
this document for information on interpreting diagnostic lights and audible codes.

●

Press and hold any key. If the system beeps, then your keyboard is operating correctly.
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●

Check all cables for loose or incorrect connections.

●

Wake the workstation by pressing any key on the keyboard or the power button. If the system
remains in suspend mode, shut down the system by pressing and holding the power button for at
least four seconds, then press the power button again to restart the system. If the system does not
shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart,
press the power button to start the workstation.

●

Reconfigure the workstation after installing a non–plug and play expansion board or other option.
Refer to the Troubleshooting scenarios and solutions on page 117 section of this document for
instructions.

●

Be sure that all required device drivers have been installed. For example, if you have connected a
printer, you must install a printer driver.

●

If you are working on a network, plug another workstation with a different cable into the network
connection. There might be a problem with the network plug or cable.

●

If you recently added new hardware, remove the hardware and verify if the workstation functions
properly.

●

If you recently installed new software, uninstall the software and verify if the workstation functions
properly.

●

If the screen is blank, plug the monitor into a different video port on the workstation if one is
available. Alternatively, replace the monitor with a monitor that you know is working properly.

●

Upgrade the BIOS. A new release of the BIOS might have been released that supports new
features or fixes your problem.

Customizing the monitor display
You can manually select or change the monitor model, refresh rates, screen resolution, color settings,
font sizes, and power management settings. To do so, right-click the desktop, then click Screen
Resolution to change display settings. For more information, see the online documentation provided
with the graphics controller utility or the documentation that came with your monitor.

Troubleshooting scenarios and solutions
This section presents an extensive overview of various troubleshooting scenarios and possible solutions
for a Windows-based computer.
NOTE: For Linux troubleshooting information, refer to the HP Workstations for Linux User Manual at
http://www.hp.com/support/linux_user_manual.
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Solving minor problems
Table 6-1 Minor problems
Problem

Cause

Possible Solution

Workstation appears frozen
and does not shut down when
the power button is pressed.

Software control of the power
switch is not functional.

1.

Press and hold the power button for at least four
seconds until the computer shuts down.

2.

Disconnect the electrical plug from the outlet.

3.

Restart the computer.

1.

If possible, use the Windows Task Manager to isolate
and terminate the offending process.

2.

Attempt the normal Windows shutdown procedure.

3.

Restart the computer using the power button.

Workstation seems to be
frozen.

Program in use has stopped
responding to commands.

Workstation date and time
display is incorrect.

Real-time clock (RTC) battery
might need replacement.

1.

Reset the date and time in the Control Panel.

2.

Replace the RTC battery.

Workstation appears to pause
periodically.

Network driver is loaded and no
network connection is
established.

Establish a network connection, or use the Computer Setup
(F10) Utility or the Microsoft Windows Device Manager to
disable the network controller.

Cursor does not move using
the arrow keys on the keypad.

The Num Lock key might be on.

Press Num Lock. The Num Lock key can be disabled or
enabled in the Computer Setup (F10) Utility.

Poor performance is
experienced.

Processor is hot.

1.

Verify that airflow to the computer is not blocked.

2.

Verify that chassis fans are connected and working
properly. Some fans operate only when needed.

3.

Verify that the processor heatsink is installed properly.

Hard drive is full.
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Transfer data from the hard drive to create more space on
the hard drive.
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Table 6-1 Minor problems (continued)
Problem

Cause

Possible Solution

Workstation powered off
automatically and the Power
LED flashes red 2 times (once
every second), followed by a
2-second pause, and then two
simultaneous beeps sounded.

Processor thermal protection is
activated.

1.

Verify that the computer air vents are not blocked.

2.

Open the access panel and press the computer power
button.

3.

Verify that the system fan is running.

4.

Verify that the processor heatsink fan spins. If the fan is
not spinning, verify that the heatsink fan cable is
plugged into the system board connector and that the
heatsink is properly seated.

5.

Replace the processor heatsink.

A fan might be blocked or not
turning.
OR
The processor heatsink is not
properly attached to
the processor.

System does not power on,
and the LEDs on the front of
the computer are not flashing.

System cannot power on.

Press and hold the power button for less than four seconds.
If the hard drive LED turns green, then perform the following
steps.
1.

To find a faulty device, remove all devices one at a
time:
a.

Disconnect AC power to the computer.

b.

Remove a device.

c.

Reconnect AC power and power on the
computer.

2.

Repeat this process until the faulty device is identified.
Remove the graphics card last. Replace the faulty
device.

3.

If no faulty device is found, replace the system board.

OR
1.

2.
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Press and hold the power button for less than four
seconds. If the hard drive LED does not illuminate, then
perform the following tasks:
a.

Verify that the computer is plugged into a
working AC outlet.

b.

Verify that the power button harness is connected
to the inline front panel I/O device assembly
connector.

Verify that the power supply cables are connected to
the system board.
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Solving diskette problems
Table 6-2 Diskette problems
Problem

Cause

Solution

Diskette drive light stays on.

Diskette is damaged.

1.

Right-click Start, select Explore, and then select a
drive.

2.

Select File>Properties>Tools.

3.

Under Error-checking, select Check Now.

Drive not found.

Diskette drive cannot write to a
diskette.

Cannot format diskette.

Diskette is incorrectly inserted.

Remove and reinsert diskette.

Files on the diskette are
damaged.

Verify the program diskettes.

Drive cable is not properly
connected.

Reconnect the power cable and verify that all four pins
are connected.

Cable is loose.

Reseat the diskette drive data and power cables.

Removable drive is not seated
properly.

Reseat the drive.

Diskette is not formatted.

Format the diskette.

Diskette is write-protected.

Use another diskette or remove the write protection.

Writing to the wrong drive.

Verify the drive letter in the path statement.

There is not enough space on
the diskette.

Use another diskette.

Diskette write-control is
enabled.

Use the Computer Setup (F10) Utility to verify the storage
security feature disabled settings.

Diskette is damaged.

Replace the damaged disk.

Invalid media reported.

When formatting a disk in MS-DOS, you might need to
specify diskette capacity.
For example, to format a 1.44-MB diskette, enter the
following command at the MS-DOS prompt: FORMAT
A: /F:1440

A problem has occurred with a disk
transaction.

Diskette drive cannot read
a diskette.
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The directory structure is bad,
or there is a problem with a
file.

1.

Right-click Start, select Explore, and then select a
drive.

2.

Select File>Properties>Tools.

3.

Under Error-checking, select Check Now.

Diskette is not formatted.

Format the diskette.

You are using the wrong
diskette type for the drive type.

Verify the type of drive that you are using and use the
correct diskette type.

You are reading the wrong
drive.

Verify the drive letter in the path statement.

Diskette is damaged.

Replace the diskette with a new one.
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Table 6-2 Diskette problems (continued)
Problem

Cause

Solution

Invalid system disk is
displayed.

A diskette that does not contain
the system files needed to start
the computer has been inserted
into the drive.

When drive activity stops, remove the diskette and press
the Spacebar. The computer attempts to boot from the
next device in the boot order.

Diskette error has occurred.

Restart the computer by pressing the power button.

Diskette is not bootable.

Replace with a bootable diskette.

Diskette boot has been
disabled in Computer Setup.

Run the Computer Setup (F10) Utility and enable diskette
boot in Storage>Boot Order.

Removable media boot has
been disabled in Computer
Setup.

Run the Computer Setup (F10) Utility and enable
Removable Media Boot in Storage>Storage
Options.

Diskette MBR validation is
enabled.

Run the Computer Setup (F10) Utility and disable
Diskette MBR Validation in Storage>Storage
Options.

Cannot boot to diskette

Solving hard drive problems
Table 6-3 Hard drive problems
Problem

Cause

Solution

Hard drive error occurs.

Hard disk has bad sectors or
has failed.

Locate and block the usage of bad sectors. If necessary,
reformat the hard disk.
If the drive is detected by the BIOS, run DPS Self-test.

Disk transaction problem.
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The directory structure is bad,
or there is a problem with a
file.

1.

Right-click Start, select Explore, and select a drive.

2.

Select File>Properties>Tools.

3.

Under Error-checking, select Check Now.
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Table 6-3 Hard drive problems (continued)
Problem

Cause

Solution

Drive not found (identified).

Improper cable connection

On computers with discreet data and power cables,
ensure that the data and power cables are securely
connected to the hard drive. (See the Hard drive section of
this guide for connection details.)

Improperly seated hard drive

On systems with blind-mate drive connections, check for
connector damage on the drive and in the chassis.
Reseat the hard drive and its carrier in the chassis to
ensure a proper connection. (See the Hard drive section of
this guide for connection details.)

The system might not have
automatically recognized a
newly installed device.

1.

Run the Computer Setup (F10) Utility.

2.

If the system does not recognize the new device,
verify that the device is listed in the Computer Setup
(F10) Utility.
If it is listed, the probable cause is a driver problem.
If it is not listed, the probable cause is a hardware
problem.

3.

Nonsystem disk or NTLDR missing
message.

Drive responds slowly
immediately after power-up.

Run the Computer Setup (F10) utility, and increase the
POST Delay in Advanced>Power-On Options.

System is trying to start from a
nonbootable diskette.

Remove the diskette from the drive.

System is trying to start from a
damaged hard drive.

1.

Insert a bootable diskette into the drive and restart
the computer.

2.

If the hard drive is still inaccessible and MBR Security
is enabled, try restoring the previously saved
MBR image by entering Setup and selecting
Security>Restore Master Boot Record.

1.

Insert a bootable system diskette and restart.

2.

Verify that the hard drive is partitioned and
formatted.

3.

Install the system files for the appropriate operating
system, if necessary.

System files missing or not
properly installed.

Workstation will not start.
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If this drive is newly installed, enter Setup and try
adding a POST delay under Advanced>Power-On.

Hard drive boot disabled in
Computer Setup.

Run the Computer Setup (F10) Utility and enable the hard
drive entry in the Storage>Boot Order list.

Hard drive is damaged.

Replace the hard drive.
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Solving display problems
Table 6-4 Display problems
Problem

Cause

Solution

Blank screen (no video).

The cable connections are not
correct.

Verify the cable connections from the monitor to the
computer and to a working electrical outlet.

The monitor is off.

Turn the monitor on (LED is on). You might need to refer to
the monitor manual for an explanation of LED signals.

Screen blanking utility installed
or energy saver features
enabled.

Press a key or the mouse button and, if set, enter your
password.

System ROM is bad; system is
running in FailSafe Boot Block
mode (indicated by 8 beeps).

Reflash the ROM using a SoftPaq.

Fixed-sync monitor does not
sync at the resolution
specified.

Verify that the monitor can accept the same horizontal
scan rate as the resolution specified.

Computer is in Hibernate
mode.

Press the power button to resume from Hibernate mode.

Workstation monitor settings
are not compatible with the
monitor.

1.

When you see Press F8 in the bottom-right corner of
the screen, restart the computer and press F8 during
startup.

2.

Using the keyboard arrow keys, select Enable VGA
Mode and then press Enter.

3.

For Windows, double-click the Display icon in the
Control Panel and then select the Settings tab.

4.

Use the sliding control to reset the resolution.

1.

For Windows, restart your computer in VGA mode.

2.

After the operating system starts, change the display
settings to match those supported by your graphics
card and monitor.

3.

Refer to your operating system and graphics card
documentation for information about changing
display settings.

The display works properly during
the POST but goes blank when the
operating system starts.

Power LED flashes red 6 times
(once every second), followed by a
2–second pause, and then the
computer beeps 6 times.

Monitor does not function when
used with Energy Saver features.
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The display settings in the
operating system are
incompatible with your
graphics card and monitor.

Prevideo graphics error.

Monitor without Energy Saver
capabilities is being used with
Energy Saver features
enabled.

For systems with a graphics card:
1.

Reseat the graphics card.

2.

If the card requires external power, make sure the
power cable is properly connected.

3.

Replace the graphics card.

4.

Replace the system board.

Disable the monitor Energy Saver feature.

Troubleshooting scenarios and solutions
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Table 6-4 Display problems (continued)
Problem

Cause

Solution

Dim characters

The brightness and contrast
controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly
connected.

Verify that the graphics cable is connected to the graphics
card and the monitor.

If the graphics controller was
upgraded, the correct video
drivers might not be loaded.

Install the video drivers included in the upgrade kit, or
download and install the latest drivers for your graphics
card from http://welcome.hp.com/country/us/en/
support.html.

Monitor cannot display
requested resolution.

Change the requested resolution.

The monitor connections might
be faulty, or the monitor might
be incorrectly adjusted.

1.

Be sure the monitor cable is securely connected to the
computer.

2.

In a multiple CRT monitor system, ensure that the
monitors' electromagnetic fields are not interfering
with each other . Move them apart if necessary.

3.

Move fluorescent lights or fans that are too close to
the CRT monitor.

Blurry video or requested
resolution cannot be set.

The picture is broken up, rolls,
jitters, or flashes.

Monitor must be degaussed.

Degauss the monitor.

Vibrating or rattling noise coming
from inside a CRT monitor when
powered on.

Monitor degaussing coil has
been activated.

None. It is normal for the degaussing coil to be activated
when the monitor is powered on.

Clicking noise coming from inside
a CRT monitor.

Electronic relays have been
activated inside the monitor.

None. It is normal for some monitors to make a clicking
noise when turned on and off, when going in and out of
Standby mode, and when changing resolutions.

High pitched noise coming from
inside a flat-panel monitor.

Brightness and contrast
settings are too high.

Lower brightness and contrast settings.

Fuzzy focus; streaking, ghosting,
or shadowing effects; horizontal
scrolling lines; faint vertical bars;
or unable to center the picture on
the screen (flat-panel monitors
using an analog VGA input
connection only.)

Flat-panel monitor’s internal
digital conversion circuits
might be unable to correctly
interpret the output
synchronization of the
graphics card.

1.

Select the monitor’s Auto-Adjustment option in the
monitor’s onscreen display menu.

2.

Manually synchronize the Clock and Clock Phase
onscreen display functions.

3.

Download SoftPaq SP22333 to assist with the
synchronization).

Some typed symbols do not
appear correctly.

The font you are using does
not support that symbol.

Use the Character Map to locate and select the
appropriate symbol.
Select Start>All Programs> Accessories>System
Tools>Character Map. You can copy the symbol from
the Character Map into a document.
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Solving audio problems
Table 6-5 Audio problems
Problem

Cause

Solution

Sound does not come out of the
speaker or headphones.

Software volume control is
turned down.

Double-click the Speaker icon on the taskbar and use the
volume slider to adjust the volume.

The external speakers are not
turned on.

Turn on the external speakers.

External speakers plugged into
the wrong audio jack.

See your sound card documentation for proper speaker
connection.

Digital CD audio is
not enabled.

Enable digital CD audio:
From the Control Panel, select System.

2.

On the Hardware tab, select the Device Manager
button.

3.

Right-click the CD/DVD device and select
Properties.

4.

On the Properties tab, select Enable digital CD
audio for this CD-ROM device.

Headphones or devices
connected to the line-out
connector have muted the
internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external
speakers.

Volume is muted.

1.

From the Control Panel, select Sound, Speech and
Audio Devices, and then select Sounds and
Audio Devices.

2.

Deselect the Mute checkbox.

Computer is in Standby mode.
Noise or no sound comes out of
the speakers or headphones.

1.

Press the power button to resume from Standby mode.
1.

If you are using digital speakers that have a stereo
jack and you want the system to autoswitch to digital,
use a stereo-to-mono adapter to engage the auto
sense feature, or use multimedia device properties
to switch the audio signal from analog to digital.

2.

If the headphones have a mono jack, use the
multimedia device properties to switch the system to
analog out.
NOTE: If you set digital as the Output Mode, the
internal speaker and external analog speakers no
longer output audio until you switch back to an auto
sense or analog mode.
If you set analog as the Output Mode, external digital
speakers do not function until you change the output
mode back to an auto-sense or digital mode.
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Table 6-5 Audio problems (continued)
Problem

Cause

Solution

Sound occurs intermittently.

Processor resources are being
used by other open
applications.

Shut down all open processor-intensive applications.

Workstation appears to be locked
up while recording audio.

The hard disk might be full.

1.

Before recording, be sure there is enough free space
on the hard disk.

2.

Try recording the audio file in a compressed format.

Solving printer problems
Table 6-6 Printer problems
Problem
Printer does not print.

Cause

Solution

Printer is not turned on and
online.

Turn the printer on and be sure it is online.

The correct printer driver for
the application is not installed.

1.

Install the correct printer driver for the application.

2.

Try printing using the MS-DOS command:
DIR C:\> [printer port]
Replace printer port with the address of the printer
used. If the printer works, reload the printer driver.

Printer does not turn on.

If you are on a network, you
might not have made a
connection to the printer.

Make the proper network connection to the printer.

Printer might have failed.

Run printer self-test.

The cables might not be
connected properly.

Self-troubleshooting with HP Vision Diagnostics
HP Vision Diagnostics is a diagnostic tool that can be used by the end user or technical support
personnel to view information about the hardware configuration of the computer and perform hardware
troubleshooting on HP Workstation and Desktop systems. Booted from either DVD/CD or USB flash
key, these diagnostics run outside the operating system and make it easier to isolate potential issues
and determine hardware failures.
HP Vision Diagnostics provides:
●
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Capture complete system configuration information that can be shared as an HTML file, including:
◦

System serial number

◦

System product number

◦

System BIOS revision
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●

◦

Memory size and configuration

◦

Processor information

◦

Storage device information and configuration

◦

Graphics / audio / communications information and configuration

Comprehensive diagnostic tests with:
◦

Highly configurable testing options (quick / complete / custom / interactive / non-interactive)

◦

Specific failing memory DIMM identification

◦

Tests for video card memory

◦

DST Smart tests for both SATA and SAS drives

◦

Other tests and diagnostics

●

Diagnostic Failure Code Output – A unique warranty code is generated for each failure which can
be used to validate diagnostic usage for a specific system

●

Ease-of-use - uses similar user interface as previous field diagnostics, HP Insight Diagnostics

●

True end-to-end diagnostics – same diagnostics modules as used in the factory

Use HP Vision Diagnostics to determine if all the devices installed on the computer are recognized by
the system and functioning properly. Running tests is optional but recommended after installing or
connecting a new device.
You can run tests, save the test results, and print them so that you have printed reports available before
placing a call to the Customer Support Center.
NOTE: Not all third-party devices may be detected by HP Vision Diagnostics.

Accessing HP Vision Diagnostics
There are three ways to access, install and use HP Vision Diagnostics:
●

Use the Vision Creator utility, pre-installed on your workstation, to burn HP Vision Diagnostics to
CD or DVD.

●

Use additional preinstalled utilities on your workstation to either:

●
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◦

Create a bootable USB flash key or

◦

Create a bootable DVD or CD.

If for some reason the above options are not available (for example, your primary hard drive was
erased and then restored), you can download HP Vision Diagnostics from the HP Web site.

Self-troubleshooting with HP Vision Diagnostics
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Using Vision Creator
HP Vision Creator is pre-installed on your workstation and makes it easy to burn HP Vision Diagnostics
onto a CD or DVD:
1.

To initiate Vision Creator, select: Start > All Programs > PC Help & Tools > HP Vision
Diagnostics Disc Creation.

2.

Follow the prompts to burn HP Vision Diagnostics onto optical media.

Accessing HP Vision Diagnostics Utilities
These procedures describe how to access the HP Vision Diagnostics utilities that are included in the
computer software.

Creating and using a bootable USB key
This section describes how to use a USB key to access the HP Vision Diagnostics.
NOTE: Using a USB key is the most convenient method to access HP Vision Diagnostics.
1.

In the C:\VisionDiagnostics\ directory, double-click on VisionDiagUSB.exe. A setup menu
appears.

2.

Follow the setup prompts to create a bootable ISO image of the diagnostic utilities on a USB key.

3.

Turn off the computer and restart it with the USB key installed. The computer will boot to the USB
key and initiate the HP Vision Diagnostics utility.

4.

Follow the HP Vision Diagnostic prompts to troubleshoot the computer.

Creating and using a bootable DVD/CD
This section describes how to use a DVD/CD to run the HP Vision Diagnostics.
1.

In the C:\VisionDiagnostics\ directory, double-click on the VisionDiagISO.exe file. A setup menu
appears.

2.

Follow the setup prompts to create a bootable ISO image of the diagnostic utilities on a DVD/CD.

3.

Enable the computer to boot from DVD/CD.

4.

Turn off the computer and restart it with the DVD/CD installed in the optical drive. The computer
will boot from the DVD/CD and initiate the HP Vision Diagnostics utility.

5.

Follow the HP Vision Diagnostic prompts to troubleshoot the computer.

Using the HP Memory Test utility
This section describes how to access the HP Memory Test utility.
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NOTE: The HP Memory Test is a comprehensive memory diagnostic utility that is run as a stand-alone
application, outside of HP Vision Diagnostics.
If the computer is booted from a DVD/CD, a separate boot DVD/CD will be required to use the
memory diagnostic. Hence, HP recommends that a USB key be used to boot the diagnostic utilities. It is
faster than using a DVD/CD, and it accommodates both the Memory Test and Vision Diagnostics.
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1.

In the C:\VisionDiagnostics\ directory, double-click on the MemoryDiagISO.exe file. A setup
menu appears.

2.

Follow the setup prompts to create a bootable ISO image of the memory diagnostic utility on a
DVD/CD.

3.

Turn off the computer and restart it with the DVD/CD installed in the optical drive. The computer
will boot from the DVD/CD and initiate the memory diagnostic utility.

4.

Follow the diagnostic prompts to troubleshoot computer memory.
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Downloading HP Vision Diagnostics
If for some reason neither Vision Creator nor HP Vision Diagnostics are available on your workstation,
follow these steps to download HP Vision Diagnostics from the HP Web site and load onto a USB flash
drive or DVD/CD:
1.

Go to http://www.hp.com/go/workstationsupport.

2.

Select your workstation.

3.

Click Download drivers and software.

4.

Select your language and operating system.

5.

Select the Diagnostic link.

6.

Locate HP Vision Diagnostics under “Quick jump to downloads by category...” for either USB
or CD (as desired) and select Download.

7.

Depending on whether you chose USB or DVD/CD:
a.

USB: Run the .exe file that is downloaded, then follow the prompts to save HP Vision
Diagnostics and load it onto a USB flash key.

b.

DVD/CD: Run the .exe file that is downloaded, then follow the installer prompts to extract
and save the .iso file to your hard drive. Use CD-ROM burning software to copy the .iso file
to an optical medium.

8.

When the DVD/CD or USB flash drive has the utility installed, insert the USB flash drive or DVD/
CD into the computer (while it is on).

9.

Shut down the workstation using the operating system.

10. Turn on the computer. The system should boot into HP Vision Diagnostics.
NOTE: If the system does not boot to the DVD/CD in the optical drive or to the USB flash drive,
you may need to change the boot order. You may use the Computer Setup (F10) utility to change
the boot order, or you may press F9 to select the appropriate boot device.
11. At the boot menu, select either the HP Vision Diagnostics utility to test the various hardware
components in the computer or the HP Memory Test utility to test memory only.
NOTE: The HP Memory Test is a comprehensive memory diagnostic utility that is run as a standalone application, outside of HP Vision Diagnostics.
If the computer is booted from a DVD/CD, a separate boot DVD/CD will be required to use the
memory diagnostic. Hence, HP recommends that a USB key be used to boot the diagnostic
utilities. It is faster than using a DVD/CD, and it accommodates both the Memory Test and Vision
Diagnostics.
12. If running HP Vision Diagnostics, select the appropriate language and click Continue.
13. In the End User License Agreement page, select Agree if you agree with the terms. The HP Vision
Diagnostics utility launches with the Survey tab displayed
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User interface
The HP Vision Diagnostics application provides six major functions, accessible through Tabs. These
functions are:
●

Survey — Your current system hardware information.

●

Test — List all diagnostics available for your system. Tests are started there.

●

Status — This screen shows progress and status of currently running diagnostics.

●

History — All past diagnostics runs and status are listed there.

●

Errors — All past diagnostics failures are listed there.

●

Help — User help about HP Vision Diagnostics.

There are also some common operations that are part of the utility. They include:
●

Exit Diagnostics button — This button will close HP Vision Diagnostic application and reboot
your system. Any running test will be aborted.

●

Reload button — If available, this button will rescan your system hardware and reload the
diagnostics without the need to restart your entire system.

●

Save button — If available, save your system survey, test history or error data as an HTML file to
a floppy disk or a USB key drive.

Survey tab
The Survey tab shows your system hardware information, organized into eleven Categories (for
example "Processors") and device instances (for example "Processor 1").
The amount of information displayed can be controlled by selecting a combination of View Level and
Category.
The View Levels include:
●

Overview — Shows high level summary of the system hardware. This is the default view level.

●

Summary — Gives limited configuration data for each specific Category.

●

Advanced — Offers more technical and low-level data for the computer-savvy user.

The Categories Levels include:
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●

All — Shows all Categories.

●

Architecture — Shows system architecture information such as high level PCI devices, low level
SMBIOS, CMOS and PCI configuration space data.

●

Audio — Shows all embedded and add-on audio devices.

●

Asset Control — Shows asset control related information such as product name, serial number,
asset tag, and universal unique ID information.

●

Communication — Shows communication devices such as serial, parallel, USB, network,
Firewire, modem, and Bluetooth ports and devices.

●

Graphics — Shows all embedded and add-on video cards.

Self-troubleshooting with HP Vision Diagnostics

131

●

Input Devices — Shows user input devices such as all connected mice and keyboards.

●

Memory — Shows system memory information.

●

Miscellaneous — List any devices or data that doesn't belong to any other Category.

●

Processors - Shows system processors.

●

Storage — Shows mass storage devices such as floppy drives, optical drives, SATA, SAS hard
disk drives and controllers, as well as any RAID arrays.

●

System — Shows information about system board devices such as fans and cables.

Test tab
The Test tab lists all available diagnostics. The lists have been tailored according to your system
configuration. Individual test may be selected or unselected. The following Test Modes exist:
●

Quick — This test selection was picked to perform quickly while covering your entire hardware.
Test parameters cannot be modified.

●

Complete — This test selection offers all available tests and may take a long time to complete.
Test parameters cannot be modified.

●

Custom — Like Complete this test selection offers all available tests. The test parameters may be
modified to fit specific needs. For advanced users only!

By default, the three test modes do not display prompts and require no interaction. If errors are found,
they are displayed when testing is complete.
However, for each test type, you may also optionally add interactive tests by clicking the Include
interactive tests box under Test mode. Selecting interactive tests provides the maximum control over
the testing process. The diagnostic software will prompt you for input during tests.
NOTE: Memory can not be tested from within the HP Vision Diagnostics application. To test the
memory in your computer, exit HP Vision Diagnostic, boot to either the CD or USB flash drive and
select HP Memory Test from the boot menu.
The Duration of Test options control the duration of the test sequence. The following options are
available:
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●

Number of loops — A test selection will run once by default. Enter a positive number to make
a test selection run many times.

●

Total test time (hours:minutes) — Alternatively, the test selection can be set to run for a
specified amount of time. This does not guarantee that all tests will run if the entered time is less
than the necessary time to run all the tests

●

Stop at first error— Check this option to stop test execution as soon as one error is
encountered.
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The following Test Controls exist:
●

Select All, Unselect All button — This button toggles to select or unselect all the tests from the
test selection tree.

●

Expand, Collapse button — This button toggles to expand or collapse the test selection tree.

●

Start Test button — Click this button to start executing all selected tests. HP Vision Diagnostics
will automatically switch to the Status tab in order to keep track of the test execution and status.

WARNING!
completed.

Once started, do not reboot or power off your computer until all the tests have been

To begin testing:
1.

Select the Test tab.

2.

Select the type of tests you want to run: Quick, Complete, or Custom.

3.

Include optional interactive tests by selecting Include interactive tests.

4.

Choose how you want the test to be executed, either Number of Loops or Total Test Time.
When choosing to run the test over a specified number of loops, enter the number of loops to
perform. If you want the diagnostic test for a specified time period, enter the amount of time in
minutes.

5.

Click the Start Test button to start the testing. The Status tab, which allows you to monitor the
progress of the tests, is automatically displayed during the testing process. When the tests are
complete, the Status tab shows whether the devices passed or failed.

6.

If errors are found, go to the Errors tab to display detailed information and recommended actions.

Status tab
The Status tab shows the overall progress and status of the test scenario as well as the progress and
status of each test. The color coded status are black, blue, green, red, and orange.
The Status tab colors are:
●

Waiting (black) — No test is running.

●

Running (blue) — At least one test is currently running.

●

Passed (green) — All tests have run successfully, meaning that no hardware error or defect was
detected.

●

Failed (red) — The tests have detected at least one error with your system.

●

Canceled (orange) — The test scenario has been explicitly canceled, in which case no pass or
fail conclusion can be drawn.

The available data is:
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●

Current Loop — Shows the current execution loop out of total number of loops specified in the
Test panel.

●

Test Time — Shows the total time elapsed since the beginning of the test execution.
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●

Test Complete — Shows the number of tests successfully completed out of the total number of
test to execute.

●

Cancel button — Push the Cancel button to immediately terminate all currently running tests.

History tab
The History tab shows the history of the past test executions.
The History Log displays all tests that have been executed, the number of times of execution, the number
of times failed, the date each test was executed, and the time it took to complete each test. The Clear
History button will clear the contents of the History Log.
The contents of the History Log may be saved as a HTML file to either floppy or USB flash drive by
clicking the Save button.

Errors tab
The Errors tab displays detailed information about any errors found, as well as any recommended
actions.
The Error Log displays the tests for devices that have failed during the diagnostic testing and includes
the following columns of information.
●

The Device section displays the device tested.

●

The Test section displays the type of test run.

●

The Times Failed is the number of times the device has failed a test.

●

The Defect Code provides a numerical code for the failure. The error codes are defined in the
Help tab.

●

The Description section describes the error that the diagnostic test found.

●

The Reason section describes the likely cause of the error.

●

The Recommended Repair will give a recommended action that should be performed to resolve the
failed hardware.

●

The Warranty ID is a unique error code associated with the specific error on your computer.
When contacting the HP Support Center for assistance with a hardware failure, please be
prepared to provide the Warranty ID.

●

The Clear Errors button will clear the contents of the Error Log.

The contents of the Error Log may be saved as a HTML file to either floppy or USB flash drive by
clicking the Save button.

Help tab
The Help tab contains a Vision Help section, and a Test Components section. This tab includes search
and index features. You may also review the HP End User License Agreement (EULA), as well as the HP
Vision Diagnostic application version information on this tab.
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The various sections located here are:
●

The Vision Help section contains information on the major functions of HP Vision Diagnostics.

●

The Test components section provides a description of each test, as well as the parameters that
may be adjusted when running in Custom test mode.

●

The Defect codes section contains information on the numerical error code that may appear in the
Errors tab.

●

The Memory test tab section provides information on the HP Memory Test application that may be
launched from the boot menu.

●

The HP Support section provides information on obtaining technical support from HP.

Saving and printing information in HP Vision Diagnostics
You can save the information displayed in the HP Vision Diagnostics Survey, History and Errors tabs to
a diskette or a USB flash drive. You can not save to the hard drive. The system will automatically create
an html file that has the same appearance as the information displayed on the screen.
1.

Insert a diskette or USB flash drive if running HP Vision Diagnostics from CD.

2.

Click Save in the bottom on any of the Survey, History or Errors tabs. All three log files will be
saved regardless of from which tab the Save button was clicked.

3.

Select the drive onto which you will save the log files and click the Save button. Three html files
will be saved to the inserted diskette or USB flash drive.
NOTE: Do not remove the diskette or USB key until you see a message indicating that the html
files have been written to the media.

4.

Print the desired information from the storage device used to save it.
NOTE: To exit HP Vision Diagnostics, click the Exit Diagnostics button at the bottom of the
screen. Be sure to remove the USB flash drive or CD from the optical drive.

Diagnostic codes and errors
This section presents information about diagnostic LED codes, LED color definitions, and POST error
messages to help you troubleshoot problems.

Diagnostic LED and audible (beep) codes
This section describes the front panel LED error and operation codes as well as the audible codes that
might occur before or during the POST.
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Table 6-7 Diagnostic lights and audible codes
Activity

Possible cause

Blue Power LED* on. No
beeps.

Computer on.

Blue Power LED* blinks every
two seconds.* No beeps.

Computer in Sleep mode
(S3-Suspend to RAM). Select
models only.

Blue Power LED* is off.* No
beeps.

Computer in Hibernate
mode (S4-Suspend to disk)
or system is off (S5).

Blue Power LED* blinks three
times*, once per second.*
No beeps.

Computer in Sleep mode
(S3-Suspend to RAM). Select
models only.

Blue Power LED* blinks four
times*, once per second.*
No beeps.

Computer in Hibernate
mode (S4-Suspend to disk).

Recommended action

N/A

*User-selectable. See The Computer Setup (F10) Utility
menu on page 28 for details.
For the following LED activity and beeps, the beeps are heard through the chassis speaker. Blinks and beeps repeat for 5 cycles, after
which, only the blinks continue to repeat.
Red Power LED blinks two
times, once every second,
followed by a two-second
pause. Two beeps.

Red Power LED blinks three
times, once every second,
followed by a two-second
pause. Three beeps.
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CPU thermal protection
activated by either of the
following methods:

CAUTION: Internal components might be powered even when the
computer is off. To prevent damage, disconnect the computer power
cord before you remove a component.

●

A fan might be blocked
or not turning.

1.

Ensure that the computer air vents are not blocked and the cooling
fan is running.

●

The heatsink and fan
assembly is not
properly attached to
the CPU.

2.

Open the access panel, press power button, and verify that the CPU
fan is spinning. If the CPU fan is not spinning, make sure the fan
cable is plugged into the computer board header. Ensure the fan is
fully and properly seated or installed.

3.

If fan is plugged in and seated properly, but is not spinning, the
problem might be in the CPU fan. Contact HP for assistance.

4.

Verify that the fan assembly is properly attached. If problems
persist, there might be a problem with the CPU heatsink. Contact
HP for assistance.

1.

Verify that the CPU is present.

2.

Reseat the CPU.

CPU not installed (not an
indicator of bad CPU).
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Table 6-7 Diagnostic lights and audible codes (continued)
Activity
Red Power LED blinks four
times, once every second,
followed by a two-second
pause. Four beeps.

Red Power LED blinks five
times, once every second,
followed by a two-second
pause. Five beeps.

Red Power LED blinks six
times, once every second,
followed by a two-second
pause. Six beeps.

Red Power LED blinks seven
times, once every second,
followed by a two- second
pause. Seven beeps.

Possible cause
Power failure (power supply
is overloaded)

Pre-video memory error

Pre-video graphics error.

System board failure (ROM
detected failure prior to
video).

Recommended action
CAUTION: Internal components might be powered even when the
computer is off. To prevent damage, disconnect the computer power
cord before you remove a component.
1.

Open the access panel and ensure that all power connections (20pin Main, 4-pin CPU) are secure on the system board.

2.

Check if a device is causing the problem by removing all attached
devices (such as hard, diskette, or optical disk drives, and
expansion cards.) Power on the computer. If the system enters the
POST, power off and replace one device at a time; repeat this
procedure until failure occurs. Replace the device that is causing the
failure. Continue adding devices one at a time to ensure all devices
are functioning properly.

CAUTION: Internal components might be powered even when the
computer is off. To prevent damage, disconnect the computer power
cord before you remove a component.
1.

Reseat DIMMs.

2.

Replace DIMMs one at a time to isolate faulty module.

3.

Replace third-party memory with HP memory.

4.

The problem might be on the system board. Contact HP for
assistance.

CAUTION: Internal components might be powered even when the
computer is off. To prevent damage, disconnect the computer power
cord before you remove a component.
1.

Reseat the graphics card.

2.

Verify the graphics auxiliary power cable is connected (if
applicable).

3.

Insert the graphics card into another available slot.

4.

The problem might be on the graphics card. Contact HP for
assistance.

1.

Clear CMOS.
NOTE: Refer to the Configuring password security and resetting
CMOS on page 150 section for detailed information on clearing
CMOS.

2.
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The problem might be on the system board. Contact HP for
assistance.
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Table 6-7 Diagnostic lights and audible codes (continued)
Activity
Red Power LED blinks eight
times, once every second,
followed by a two-second
pause. Eight beeps.

Possible cause
Invalid ROM based on bad
checksum.

Recommended action
CAUTION: Internal components might be powered even when the
computer is off. To prevent damage, disconnect the computer power
cord before you remove a component.
1.

Clear CMOS.
NOTE: Refer to the Configuring password security and resetting
CMOS on page 150 section for detailed information on clearing
CMOS.

Red Power LED blinks nine
times, once every second,
followed by a two-second
pause. Nine beeps.

System powers on but does
not start.

System does not power-on
and LEDs are not blinking.
No beeps.

System unable to power on.

2.

Upgrade the ROM using SoftPaq, either from the hard disk drive,
CD, diskette, or USB removable device (for example, HP Drive
Key). See the ROM Flash section of the Maintenance and Service
Guide at http://www.hp.com/support/workstation_manuals.
SoftPaq is a self-extracting executable, which contains instructions
for its use, that enables you to upgrade the ROM. To download the
Softpaq executable, visit http://www.hp.com/go/
workstationsupport.

3.

The problem might be on the system board. Contact HP for
assistance.

1.

The problem might be on the system board. Contact HP for
assistance.

2.

The problem might be in the CPU. Contact HP for assistance.

CAUTION: Internal components might be powered even when the
computer is off. To prevent damage, disconnect the computer power
cord before you remove a component.
To resolve the problem, choose one of the following options:
Press and hold the power button for less than 4 seconds. If the hard disk
drive LED turns green, then:
1.

Remove the expansion cards one at a time and try holding the
power button again for less than 4 seconds.

2.

The problem might be on the system board. Contact HP for
assistance.

Press and hold the power button for less than 4 seconds. If the hard disk
drive LED does not turn on green then:

*
*

1.

Check that unit is plugged into a working AC outlet.

2.

Open the access panel and check that the power button harness is
properly connected to the system board.

3.

Check that all power supply cables are properly connected to the
system board.

The BIOS option you select controls the blue LED function during these suspend modes.
The z210 computer does not have BIST LED functionality.

*
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LED color definitions
The following table describes what each LED light on the computer front panel signifies.
Table 6-8 LED color definitions
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LED state

LED color

System status

Solid

Blue

System is on.

Flashing

Blue

System is in Standby.

Solid or flashing

Red

System has experienced an error. (See POST error
messages on page 140.)

None

No light

System is in Hibernate, or is off.
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POST error messages
The Power-On Self Text (POST) is a series of diagnostic tests that runs automatically when the computer
is powered on.
Audible and visual messages occur before the operating system starts if the POST encounters a
problem. POST checks the following items to ensure that the computer system is functioning properly:
●

Keyboard

●

DIMMs

●

Diskette drives

●

All mass storage devices

●

CPUs

●

Controllers

●

Fans

●

Temperature sensors

●

Cables (front/rear panels, audio, and USB ports)

The table shown next describes the POST error messages.
Table 6-9 POST error messages
Screen message

Probable cause

Recommended action

101—Option ROM Checksum
Error

System ROM checksum.

Verify the you have the latest ROM:

102—System Board Failure

110—Out of memory space
for option ROMs

DMA, timers, and so forth, might be
set improperly or might be defective.

Option ROM for a device could not
run because of memory constraints.

1.

Flash the ROM, if needed.

2.

If an expansion card was recently added, remove
it to find out if the problem remains.

3.

Clear CMOS. If the message disappears, there
might be a problem with the expansion card.

4.

Replace the system board.

1.

Clear the CMOS.

2.

Remove the expansion boards.

3.

Replace the system board.

Run the Computer Setup (F10) Utility to disable
unneeded option ROMs, and to enable ACP1/USB
Buffers at Top of Memory.

162—Systems Options Error
163—Time and Date Not Set

●

Invalid time or date in
configuration memory.

●

RTC battery might need
replacement.

●
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1.

Set the date and time from the Control Panel or in
the Computer Setup (F10) Utility (depending on
the operating system).

2.

If the problem persists, replace the RTC battery.

CMOS jumper might not be
properly installed.
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Table 6-9 POST error messages (continued)
Screen message

Probable cause

Recommended action

164—Memory Size Error

Memory configuration is incorrect.

1.

Run the Computer Setup (F10) Utility or the
Windows utilities.

2.

Verify that the memory modules are installed
properly.

3.

If third-party memory has been added, test the
memory configuration using HP memory.

4.

Verify the memory module type.

1.

Run the Computer Setup (F10) utility or the
Windows utilities.

2.

Be sure that memory modules are installed
correctly.

3.

Verify the memory module type.

4.

Remove and replace memory modules one at a
time to isolate faulty modules.

5.

Replace faulty memory modules.

6.

If the error persists after replacing memory
modules, replace the system board.

201—Memory Error
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RAM failure.

202—Memory Type Mismatch

Memory modules do not match.

Replace the memory modules with matched sets.

203—Memory module failed
self-test and failing rank was
disabled

Defective memory module.

Replace the memory module.

204—Memory module failed
and user rank was disabled

Improper module load.

Reseat the memory module correctly.

205—Memory high
temperature detected

Insufficient memory module cooling.

Verify that a memory module cooling fan is installed
and operating.

206—Memory setup invalid

Memory configured incorrectly.

Reconfigure the memory modules in the proper slots.

207—Incompatible DIMMs
detected

DIMMs are installed that do not fulfill
system requirements.

1.

Verify that the memory module type matches
computer requirements.

2.

Insert the DIMM in the proper memory socket.

3.

Replace the DIMM if the problem persists.

208—Mismatched DIMMs
detected

Installed DIMMs are improperly
matched.

Verify that matching DIMMs are installed.

209—Memory warning
condition detected

Incorrect memory module type in use.

Verify that the memory modules are compatible with
computer requirements.

212—Failed Processor 0

Processor has failed to initialize.

1.

Reseat the processor in its socket.

2.

If the processor does not respond, replace it.

3.

Replace the system board.
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Table 6-9 POST error messages (continued)
Screen message

Probable cause

Recommended action

213—Incompatible Memory
Modules

A memory module in the memory
socket identified in the error message
is missing critical SPD information, or
is incompatible with the chipset.

1.

Verify the memory module type.

2.

Insert the DIMM in another memory socket.

3.

Replace the module with a DIMM conforming
to the SPD standard.

DIMMs are not installed correctly (not
paired correctly).

See the service label on the computer access panel for
the correct memory configurations, and reseat the
DIMMs accordingly.

216—Memory Size Exceeds
Maximum Supported

The amount of memory installed
exceeds that supported by the
hardware.

1.

Verify how much memory the computer supports.

2.

Remove the excess memory.

301—Keyboard Error

Keyboard failure.

1.

Reconnect the keyboard with the computer
powered off.

2.

Check the connector for bent or missing pins.

3.

Be sure that none of the keys are pressed.

4.

Replace the keyboard.

1.

Reconnect the keyboard with the computer
powered off.

2.

Connect a keyboard directly to the computer
(instead of through a switch box).

3.

Replace the system board.

1.

Reconnect the keyboard with the computer
powered off.

2.

Connect a keyboard directly to the computer
(instead of through a switch box).

3.

Be sure that none of the keys are pressed.

4.

Replace keyboard.

5.

Replace system board.

214—DIMM Configuration
Warning
215—DIMM Configuration
Error

303—Keyboard Controller
Error

304—Keyboard or System
Unit Error

Keyboard failure.

510—Splash Screen image
corrupted

Splash Screen image has errors.

Update system BIOS.

511—CPU Fan not detected

Fan is not connected or is defective.

1.

Reseat the fan cable.

2.

Reseat the fan.

3.

Replace the fan.

1.

Reseat the fan cable.

2.

Reseat the fan.

3.

Replace the fan.

512—Rear Chassis fan not
detected
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I/O board keyboard controller is
defective or is not set properly.

Rear fan missing, disconnected, or
defective.
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Table 6-9 POST error messages (continued)
Screen message

Probable cause

Recommended action

513—Front Chassis fan not
detected

Front fan missing, disconnected, or
defective.

1.

Reseat the fan cable.

2.

Reseat the fan.

3.

Replace the fan.

1.

Reseat the fan cable.

2.

Reseat the fan.

3.

Replace the fan.

1.

If necessary, add a heatsink to the processor and
ensure proper operation.

2.

Replace the processor.

1.

Reseat the fan cable.

2.

Reseat the fan.

3.

Replace the fan.

514—Memory fan not
detected

515—CPU Overtemp
occurred

516—Chipset fan not detected

Insufficient processor cooling or
processor defect.

Chipset fan missing, disconnected, or
defective.

517—Low power CPU
heatsink(s) detected for high
power CPUs

Inadequate heatsink is installed.

Replace the low power heatsink with a high power
heatsink.

518—Power supply wattage
insufficient for hardware
configuration

Computer configuration requires more
power than the power supply can
provide.

1.

Reduce the computer power consumption.

2.

Replace the power supply with a high output
power supply.

601—Diskette Controller Error

Diskette controller circuitry or diskette
drive circuitry incorrect.

1.

Run the Computer Setup (F10) utility.

2.

Verify cabling and replace defective cables if
necessary.

3.

Clear CMOS.

4.

Replace the diskette drive.

5.

Replace the system board.

1.

Run the Computer Setup (F10) Utility.

2.

Disconnect any other diskette controller devices
(tape drives).

3.

Clear the CMOS.

External storage device is not
detected, is improperly connected, or
is defective.

1.

Verify that the external device is present and
connected properly.

2.

Replace the external device.

611—Primary Floppy Port
Address Assignment Conflict

The flexible disk drive is configured at
a previously assigned address.

Select a new address for the flexible disk drive.

912—Computer Cover Has
Been Removed Since Last
System Start Up

N/A

No action required.

605—Diskette Drive Type
Error

610—External Storage Device
Failure
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Memory fan missing, disconnected, or
defective.

Mismatch in drive type.
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Table 6-9 POST error messages (continued)
Screen message

Probable cause

Recommended action

914— Hood Lock Coil is not
Connected

Mechanism is missing or is not
connected.

1.

Reconnect or replace the missing mechanism.

2.

Reseat or replace the missing mechanism cable.

916—Power Button Not
Connected

Power button cable is disconnected
from the system board.

Reconnect the cable and restart.

917—Front Audio Not
Connected

Front Audio mechanism is missing or is
not connected.

1.

Replace or reconnect the missing front audio
mechanism to the system board.

2.

Reseat or replace the missing mechanism cable.

1.

Replace or reconnect the missing Front USB
mechanism to the system board.

2.

Reseat or replace the missing mechanism cable.

1.

Replace or reconnect the missing Multi-Bay
mechanism to the system board.

2.

Reseat or replace the missing mechanism cable.

918—Front USB Not
Connected

919—Multi-Bay Riser Not
Connected

Front USB mechanism is missing or is
not connected.

Multi-Bay riser mechanism is missing
or is not connected.

920—Fatal error on QPI link X

Fatal error detected on QPI link x,
where x is 0 or 1. This type of error is
identified on the line following the
error message.

Potential system board problem; contact HP Support.

921—Fatal error on QPI
Protocol link X

Fatal error detected in QPI link x
protocol, where x is 0 or 1. This type
of error is identified on the line
following the error message.

Potential system board problem; contact HP Support.

922—Fatal error on PCIe slot
X

Fatal error occurred in the designated
slot.

Move the card to a different slot. If the problem
persists, replace the card.

923—Fatal error on ESI port 0

A fatal error occurred on ESI port 0.
slot.

Verify that the ESI port device is connected and
working properly.

924—Fatal error on IOH core
X

Fatal error detected on IOH core x,
where x is 0 or 1. This type of error is
identified on the line following.

Potential system board problem; contact HP Support.

925—Fatal error on IOH
miscellaneous

Fatal miscellaneous error detected on
IOH core x, where x is 0 or 1.

Potential system board problem; contact HP Support.

926—Fatal error on IOH Vtd

Fatal error detected in the Intel
Virtualization Technology.

Potential system board problem; contact HP Support.

927—Fatal error on DIMM in
slot CPU X DIMM Y

Fatal multibit ECC error detected on
the DIMM in the slot labeled DIMM x
(where x is 1 - 4), as labeled on the
system board.

Replace the DIMM in the identified slot.

928—Fatal machine check
detected on CPU X
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Screen message

Probable cause

Recommended action

1720—SMART Hard Drive
Detects Imminent Failure

Hard drive is about to fail. (Some hard
disk drives have a firmware patch that
fixes erroneous error messages.)

1.

Determine if the hard disk drive is giving a correct
error message.

2.

Run the Drive Protection System test (if
applicable).

3.

Apply firmware patch (if applicable). See
http://www.hp.com/support.

4.

Back up contents and replace the hard disk drive.

1783—Fixed Disk 0/1 locked

Hard disk drive failure.

Diagnose the hard disk drive, and replace it if
necessary.

1796—SATA Cabling Error

Missing or improperly attached cable.

Verify that a cable is attached. Reattach the cable.

1797—SATA Drivelock is not
supported in RAID mode

SATA Drivelock is not supported in
RAID mode.

Disable RAID mode, or disable SATA drivelock..

1801—Microcode Update
Error

Unknown or unsupported processor
stepping.

The microcode update failed. Check the processor
stepping to ensure it is a supported stepping. If it is
contact, HP Support.

1802—Processor Not
Supported

The system board does not support the
processor.

Replace the processor with a compatible one.

1803—Processor feature set is
insufficient for current system
settings

Processor feature set is insufficient for
current system settings. The BIOS
settings do not match the support
provided by the processor

Change the BIOS settings or upgrade the processor.

1804—A processor feature
and the memory configuration
are incompatible

A processor feature is incompatible
with the memory configuration.

Restore the previous memory configuration.

ERROR: Invalid 1394 GUID
(Invalid electronic serial
number)

No electronic serial number is stored
with the system.

To assign a serial number , select Security >System
IDs in the Computer Setup (F10) Utility.

ERROR: Invalid electronic
serial number (no number)

No electronic serial number is stored
with the system

To assign a serial number , select Security >System
IDs in the Computer Setup (F10) Utility.

ERROR: An unsupported
processor is installed. System
halted

Unsupported processor detected.

Replace the processor.

ERROR: A processor requiring
too much power is installed.
System halted

Unsupported processor detected.

Replace the processor.

Invalid electronic serial
number

Incorrect serial number registered in
the system.

To assign a serial number , select Security >System
IDs in the Computer Setup (F10) Utility.

Network Server Mode Active
and No Keyboard Attached

Keyboard not detected.

Verify that a functioning keyboard is attached to the
computer.

Processor initialization fails

Processor defective.

Replace the processor.
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Configuring RAID devices
This chapter describes how to configure SATA RAID devices on all Z-series workstations and includes
these topics:
Topics
Maximum RAID hard drive configurations on page 146
Configuring SATA RAID devices on page 147

For additional information about configuring RAIDs, see http://www.hp.com/support/RAID_FAQs. For
information about preparing the computer for RAID configuration, see http://www.hp.com/support/
workstation_manuals.

Maximum RAID hard drive configurations
This section lists the maximum number of hard drives supported on HP workstations for RAID
configurations.
NOTE: This section applies to internal workstation configurations that do not use add-in cards and
JBODs.
TIP: Use the table values to determine the workstation model-specific maximum number of hard drives
as discussed in the sections below.
Table 7-1 Maximum hard drives
Workstation

146

8.5mm (3.5") SATA

6.3mm (2.5") SATA

hard drive

hard drive

Z800

5

6

Z600

3

4

Z400

4

4

Z210 CMT

3

3

Z210 SFF

2

2
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Configuring SATA RAID devices
This section describes how to use the Intel® Rapid Storage Manager option ROM Configuration utility
to set up and manage SATA RAID volumes.
The following SATA RAID configurations are supported on this computer:
●

Up to the computer-specific maximum number of internal SATA hard disk drives and eSATA drives
(if you use an optional eSATA bulkhead cable)

●

Intel Rapid Storage Manager (IRSM) for Windows

If only a single HDD is attached, the Intel Rapid Storage Manager option ROM does not execute.
Associated messages are not displayed.
The Intel SATA AHCI BIOS executes when you select RAID+AHCI for the SATA emulation mode. This
BIOS is only used to support serial-attached drives configured as a RAID array.
This section does not apply to configuring SATA RAID in the Linux environment. For Linux SATA RAID,
refer to the Software RAID in Linux Workstations section in the HP Workstations for Linux User Guide at
http://www.hp.com/support/linux_user_manual.

Attaching SATA HDDs
Attach the required minimum number of SATA hard drives for the desired RAID level:
●

●

●

ENWW

RAID 0 – Striped disk array
◦

Two drive minimum

◦

Improved I/O performance

◦

No fault tolerance

RAID 1 — Mirrored disk array
◦

Two drives

◦

100% redundancy

◦

Can recover from single drive failure

◦

Improved read performance

RAID 5 — Striped disk array with distributed parity
◦

Three or more drives (for workstations that support three or more hard drives)

◦

Fault tolerant and provides I/O performance improvement, especially for write-biased
applications

◦

Single drive failure does not cause data loss (performance is compromised until the failed
drive is replaced and the array rebuilt).
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Configuring system BIOS
Configure the system BIOS to enable embedded SATA RAID functionality.
1.

To enter the system BIOS setup, press F10.

2.

Use the arrow keys to highlight the desired language, and then press Enter.

3.

Use the arrows to highlight Storage>Storage Options, and then press Enter.

4.

Use the up or down arrow key to highlight SATA Emulation.

5.

Use the left or right arrow key to select RAID+AHCI.

6.

To accept the new setting, press F10.

7.

Use the arrows to highlight Advanced>Power-On Options, and then press Enter.

8.

Use the up or down arrow key to highlight POST Messages.

9.

Use the left or right arrow key to select Enable.

10. To accept the new setting, press F10.
11. Use the arrow keys to highlight Advanced>Device Options, and then press Enter.
12. Use the up or down arrow key to highlight SATA RAID Option ROM Download, and then
press Enter.
13. Use the left or right arrow key to select Enable.
14. To accept the new setting, press F10.
15. Use the arrows to highlight File>Save Changes and Exit, and then press Enter.
16. Press F10 when prompted.
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Creating RAID volumes
To create RAID volumes, use the Intel Rapid Storage Manager option ROM Configuration utility.
1.

To enter the Intel Rapid Storage Manager option ROM Configuration utility, press Ctrl+l when
prompted.

2.

If required, refer the computer Maintenance and Service Guide to make available enough
physical drives to create the RAID volume.

3.

Use the up or down arrow key to highlight 1. Create RAID Volume, and then press Enter.

4.

Type the desired RAID volume name in the Name: field, and then press Tab.

5.

Use the up or down arrow key to select the RAID level in the RAID Level: field, and then press Tab.

6.

If three or more hard drives are installed (for workstations that support three or more hard drives):
a.

Press Enter to display the Select dialog.

b.

Use the up and down arrow keys and Space to mark individual physical as members of the
volume.

c.

Press Enter to exit the Select dialog and return to the Create Volume Menu dialog.

7.

If appropriate, use the up or down arrow key to select the Stripe Size in the Stripe Size: field, and
then press Tab.

8.

Enter the desired volume size in the Capacity: field, and then press Tab.

9.

Press Enter to initiate volume creation.

10. When prompted, press Y to acknowledge the warning message and create the volume.
11. Use the up or down arrow key to highlight 5. Exit, and then press Enter.
12. Press Y when prompted to confirm the exit.
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Configuring password security and
resetting CMOS
This chapter describes how to configure password security and to reset CMOS, and includes these
topics:
●

Preparing to configure passwords on page 150

●

Resetting the password jumper on page 151

●

Clearing and Resetting the CMOS on page 151

Preparing to configure passwords
The Computer Setup (F10) Utility enables you to create setup and power-on passwords.
There are three possibilities for setting passwords:
●

Define a setup password only

●

Define a power-on password only

●

Define both
When defining a setup password only, you cannot enter the setup utility without the password.
No password is needed to boot from power-on.
When defining a power-on password only, the power-on password is needed to enter F10 Setup
or to boot from power-on.
When defining both, the setup password is needed to enter F10 setup and can be used to boot
from power-on.
The power-on password cannot be used to enter the F10 Setup Utility, but it can be used to boot
from power-on.
One of the passwords will be required to boot from power on.

After you create both passwords, you can use the setup password in place of the power-on password
as an override to log into the computer (a useful feature for a network administrator).
NOTE: You can only clear the passwords with the password jumper. Clearing CMOS does not clear
the passwords.
CAUTION: Before pressing the Clear CMOS button, back up your computer CMOS settings.
Pressing the Clear CMOS button resets CMOS values to factory defaults and erases customized
information, including asset numbers and special settings.
To back up the CMOS settings, run the Computer Setup (F10) Utility and select Save to Diskette
from the File menu.
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Resetting the password jumper
Use the following procedure to disable the power-on or setup password features and clear the poweron and setup passwords.
WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure to
disconnect the power cord from the wall outlet and allow the internal system components to cool before
touching.
CAUTION: When the computer is plugged in, the power supply has voltage applied to the system
board, even when the computer is turned off. Failure to disconnect the power cord can result in
damage to the system.
CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, be sure that you are discharged of static electricity by
briefly touching a grounded metal object.
1.

Shut down the operating system, power off the computer and external devices, and disconnect the
computer power cord and external devices from power outlets.

2.

Disconnect the keyboard, monitor, and other external devices that are connected to the computer.

3.

Remove the access panel.

4.

Locate the password header and jumper.
The password header is E49. The password jumper is green so it can be easily identified.

5.

Verify that the AC power cord is disconnected from the power outlet.

6.

Remove the jumper from pins 1 and 2.

7.

Replace the access panel.

8.

Reconnect the external equipment.

9.

Reconnect AC power to the computer.

10. Power on the computer.
11. Wait for the workstation to display the HP splash screen.
12. Repeat steps 1 through 5.
13. Replace the jumper from pins 1 and 2.
14. Repeat steps 7 through 10.
15. Wait for the workstation to boot to the F10 (Setup) Utility.
16. Use the F10 (Setup) Utility to create new passwords.

Clearing and Resetting the CMOS
This section describes the steps necessary to successfully clear and reset the CMOS. The CMOS of the
computer stores password information and information about the computer configuration.
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Using the CMOS Button
To clear CMOS using the Clear CMOS button, use the following procedure:
WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.
CAUTION: When the computer is plugged in, the power supply has voltage applied to the system
board, even when the computer is powered off. Failure to disconnect the power cord can result in
damage to the system.
Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, be sure that you are discharged of static electricity by briefly touching a
grounded metal object.
1.

Shut down the operating system, power off the computer and any external devices, and then
disconnect the computer power cord and external devices from power outlets.

2.

Disconnect the keyboard, monitor, and other external devices that are connected to the computer.

3.

Remove the access panel.
CAUTION: Before pressing the Clear CMOS button, back up your computer CMOS settings.
Pressing the Clear CMOS button resets CMOS values to factory defaults and erases customized
information, including asset numbers and special settings.
To back up the CMOS settings, run the Computer Setup (F10) Utility and select Save to
Diskette from the File menu.

4.

Locate, press, and hold the CMOS button for five seconds.
NOTE: Verify that the AC power cord is disconnected from the power outlet.
The CMOS button does not clear CMOS if the power cord is connected.
For assistance locating the CMOS button and other system board components, see the system
board layout in the Replacing components section.

5.

Replace the access panel.

6.

Reconnect external devices.

7.

Plug in and power on the computer. The system boots to a F1 prompt and displays a message that
the date/time has changed and that system options have changed.

8.

Press F1. The system shuts down for three seconds and then powers back on.

9.

Use the F10 (Setup) Utility to reset the date and time.

Using the Computer Setup (F10) Utility to Reset CMOS
1.

Access the Computer Setup (F10) Utility menu.

2.

When the Computer Setup message appears in the lower-right corner of the screen, press F10,
and then press Enter to bypass the title screen, if necessary.
If you do not press F10 while the message is displayed, the computer must be rebooted to access
this utility.
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3.

From the Computer Setup (F10) Utility menu, select File>Default Setup.
This restores the settings that include boot sequence order and other factory settings. However, it
does not force hardware rediscovery.

4.

Choose Restore Factory Settings as Default, and the press F10 to accept.

5.

Select File->Apply Defaults and Exit, and then press F10 to accept.

6.

Reset the computer passwords and configuration information, such as the system date and time.
NOTE: This step does not clear the passwords.
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Connector pins
Keyboard

Mouse

Ethernet
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Appendix A Connector pins

Pin

Signal

1

Data

2

Unused

3

Ground

4

+5 VDC

5

Clock

6

Unused

Pin

Signal

1

Data

2

Unused

3

Ground

4

+5 VDC

5

Clock

6

Unused

Pin

10/100–Mb
signal

1000–Mb
signal

1

(+) Transmit Data

TX/RX

0

+

2

(-) Transmit Data

TX/RX

0

–

3

(+) Receive Data

TX/RX

1

+

4

Unused

TX/RX

2

+

5

Unused

RX/RX

2

–

6

(-) Receive Data

TX/RX

1

–

7

Unused

TX/RX

3

+

8

Unused

TX/RX

3

–
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USB

Pin

Microphone cable, 6.35 MM (1/8 inch)

1

+5 VDC

2

- Data

3

+ Data

4

Ground

Pin

Headphone cable, 6.35 MM (1/8 inch)

Audio

2 (Ring)

Power

3 (Shield)

Ground

Signal

1 (Tip)

Audio_Left

2 (Ring)

Audio_Right

3 (Shield)

Ground

Pin

Line-out audio cable, 6.35 MM (1/8 inch)

Signal

1 (Tip)

Pin

Audio line-in cable, 6.35 MM (1/8 inch)

Signal

Signal

1 (Tip)

Audio_In_Left

2 (Ring)

Audio_In_Right

3 (Shield)

Ground

Pin

Signal

1 (Tip)

Audio_Out_Left

2 (Ring)

Audio_Out_Right

3 (Shield)

Ground

SATA drive

Pin

Signal

Data Cable
S1
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Ground

Pin

Signal

Power Cable
P1

3.3V power

Pin

Signal

Power Cable
P8

5V power
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SATA drive

Pin

Signal

Pin

Data Cable

Signal

Pin

Power Cable

Signal

Power Cable

S2*

A+

P2

3.3V power

P9

S3*

A-

P3

3.3V power

P10

Ground

S4

Ground

P4

Ground

P11

Reserved

S5**

B-

P5

Ground

P12

Ground

S6**

B+

P6

Ground

P13

12V power

Ground

P7

5V power

P14

12V power

P15

12V power

S7

* S2 and S3 differential signal pair

5V power

**S5 and S6 differential signal pair

VGA

Pin

Signal

Pin

Signal

Pin

Signal

1

Red Analog

6

GND

11

Monitor ID

2

Green Analog

7

GND

12

DDC Serial Data

3

Blue Analog

8

GND

13

Horizontal Sync

4

Monitor ID

9

+5 VDC

14

Vertical Sync

5

GND

GND

15

DDC Serial Clock

10

DVI-I cable

Pin
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Signal

Pin

Signal

1

T.M.D.S DATA 2-

16

HOT PLUG DETECT

2

T.M.D.S DATA 2+

17

T.M.D.S DATA 0-

3

T.M.D.S DATA 2/4 SHIELD

18

T.M.D.S DATA 0+

Appendix A Connector pins
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DVI-I cable
4

T.M.D.S DATA 4-

5

T.M.D.S DATA 4+ 2

6

19

T.M.D.S DATA 0/5 SHIELD

0

T.M.D.S DATA 5-

DDC CLOCK

21

T.M.D.S DATA 5+

7

DDC DATA

22

T.M.D.S CLOCK SHIELD

8

ANALOG VERT. SYNC

23

T.M.D.S CLOCK+

9

T.M.D.S DATA 1-

24

T.M.D.S CLOCK-

10

T.M.D.S DATA 1+

11

T.M.D.S DATA 1/3 SHIELD

C1

ANALOG RED

12

T.M.D.S DATA 3-

C2

ANALOG GREEN

13

T.M.D.S DATA 3+

C3

ANALOG BLUE

14

+5V POWER

C4

ANALOG HORZ SYNC

15

GND

C5

ANALOG GROUND

Display port

Pin
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Signal

Pin

Signal

1

ML_Lane 0(p)

11

GND

2

GND

12

ML_Lane 3(n)

3

ML_Lane 0(n)

13

GND

4

ML_Lane 1(p)

14

GND

5

GND

15

AUX CH(p)

6

ML_Lane 1(n)

16

GND

7

ML_Lane 2(p)

17

AUX CH(n)
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Display port
8

GND

18

Hot Plug Detect

9

ML_Lane 2(n)

19

DP_PWR Return

10

ML_Lane 3(p)

20

DP_PWR

Main power cable, P1

Pin

Signal

Pin

Signal

Pin

Signal

1

5V

7

-

13

V12–B

2

GND

8

PS_ON_L

14

V12–S

3

GND

9

-

15

V12–S

4

GND

10

5V

16

-

5

GND

11

GND

17

11VSB

6

GND

12

V12–B

18

V12N

CPU power cable, P3

Pin

Color

Signal

1

BLK

GND

2

BLK

GND

3

BLK with
BRN stripes

V12CPU

4

BLK with
BRN stripes

V12CPU

CAUTION: Never connect the CPU power cable to the system board while
power is on. If you do so, the system board can be damaged and the warranty
voided. Be sure to distinguish between the CPU power cable that connects to the
system board (4-pin white connector) and the Auxiliary graphics card power
cable that connects to the PCIe x16 graphics card (6-pin black connector).
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Auxiliary graphics card power
cable, P6

Pin

Color

Signal

1

BLK/YEL

V12–G

2

BLK/YEL

V12–G

3

BLK/YEL

V12–G

4

BLK

GND

5

BLK

GND

6

BLK

GND

NOTE: The 6-pin power (auxiliary PCIe cable with black connector) can
provide up to 75 watts to PCIe graphics cards.

Internal USB 1 and USB 2, 2x5

Pin

Signal (USB1)

Signal (USB2)

1

+5V

+5V

2

+5V

+5V

3

USB6#

USB7#

4

USB9#

USB8#

5

USB6

USB7

The 2x5 connector can be mated to either
a wide 2x5 option cable connector or a
narrow 1x5 option cable connector.

6

USB9

USB8

7

GND

GND

To prevent damage to the connectors,
always connect a narrow 1x5 option cable
connector to pins 1,3,5, and 7 only of the
2x5 connector (pin 9 is not keyed on the
connector).

8

GND

GND

9

(not keyed)

(not keyed)

10

DETECT

DETECT

Pin

Signal

1

GND

2

+12V

3

Tach

4

PWM

CAUTION:

Possible equipment damage.

NOTE: USB 1 is DASH compatible using
pins 1, 3, 5, 7, and 10 (SMI).

Rear system fan
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Rear CPU fan

Internal serial
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Pin

Signal

1

GND

2

+12V

3

TACH1

4

PWM

5

TACH2

Pin

Signal

Pin

Signal

1

DTR1#

9

+5V

2

RXD1

10

+3.3V AUX

3

CTS1#

11

RTS1#

4

DSR1#

12

COM DETECT

5

TXD1

13

DCD21#

6

RI#

14

-12V

7

Ground

15

+12V

8

Ground
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System board designators
This appendix describes the system board designators for this computer.

Designator

Silk screen

Component

MTG1-MTG10

N/A

Mounting holes

E15

E15

Crisis recovery header/jumper

E49

E49

Clear password header/jumper

J9

J9 RJ/USB

LAN/DUAL USB

J10

J10 QUAD USB

Quad rear USB

J20

J20 SLOT5 PCI

PCI slot

J21

J21 SLOT6 PCI

PCI slot

J22

J22 SLOT7 PCI

PCI slot

J31

J31 SLOT1 PCIe x1

PCIe x1 slot

J32

J32 SLOT4 PCIe x16(4)

PCIe x16(4) slot

J33

J33 SLOT3 PCIe x4(1)

PCIe x4(1)

J41

J41 SLOT2 PCIe2 x16 75W

PCIe2 x16 slot

J64

DP

Display port connector

J65

DVI

DVI-I connector

J68

J68 PS2 KBD_MSE

Stacked keyboard/mouse connector

J83

J83 AUD

Triple stacked audio jacks

J86

J86

Slot2 PCIe x16 retention clip

SW50

SW50 CMOS

Clear CMOS switch/push button

P1

P1 PWR

Power supply connector (18-pin)

P3

P3 PWR CPU

CPU power connector (4-pin)

P5

P5 PB/LED

Power button/HDD LED/Power LED switch/
Side access panel sensor/Temperature header

P6

P6

Auxiliary graphics power connector

P8

P8 CHFAN

Rear system fan

P9

P9

Front fan header

P24

P24 FRONT USB

Front panel USB header

P25

P25 INTERNAL USB2

Dual internal USB header

P26

P26 INTERNAL USB3

Single internal USB header
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Designator

Silk screen

Component

P27

DASH/USB1

DASH/Dual internal USB

P29

P29 HDD LED

Hard disk drive LED connector

P54

COM

Serial port header

P60-P64

SATA0 - SATA4

SATA connectors

P65

eSATA

eSATA connector

P66 - P67

P66 - P67

SATA connectors

SATA4 - SATA5
P70

P70 CPU0 FAN

Primary CPU fan header

P124

P124 HOOD LOCK

Side access panel solenoid lock header

P126

PAR

Parallel port header

XBT1

XBT1 BAT

Battery holder

XMM1 - XMM4

XMM1 - XMM4

Memory slots

DIMM1 - DIMM4
XU1
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XU1
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Primary CPU socket
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Routine Care

General cleaning safety precautions
●

Never use solvents or flammable solutions to clean the computer.

●

Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

●

Always unplug the computer before cleaning the keyboard, mouse, or air vents.

●

Always disconnect the keyboard before cleaning it.

●

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the computer case
●

Follow the safety precautions presented in the Service Considerations section before cleaning
the computer.

●

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

●

For stronger stains, use a mild dish washing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

●

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is required because the alcohol
evaporates quickly and does not leave a residue.

●

After cleaning, always wipe the computer with a clean, lint-free cloth.

●

Occasionally, clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the keyboard
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.
●

Follow the safety precautions presented in the Service Considerations section before cleaning
the computer.

●

Visible debris underneath or between the keys can be removed by vacuuming or shaking.

●

Canned, pressurized air can be used to clean debris from under the keys. Use caution because
too much air pressure can dislodge lubricants applied under the wide keys.

●

If you remove a key, use a specially designed key remover to prevent damage to the keys. This
tool is available from many electronic supply outlets.
CAUTION: Never remove a wide key (like the space bar key) from the keyboard. If these keys
are improperly removed or installed, the keyboard might not function properly.
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●

Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be careful
not to wipe away lubricants necessary for proper key functions. Allow the parts to air dry before
reassembly.

●

Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor
●

Follow the safety precautions presented in the Service Considerations section before cleaning
the computer.

●

To clean the monitor, wipe the monitor screen with a towelette designed for cleaning monitors or a
clean cloth moistened with water.
CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the
housing and damage a component.
Never use solvents or flammable liquids on the monitor because display or housing damage may
result.

Cleaning the mouse
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1.

Follow the safety precautions presented in the Service Considerations section before cleaning
the computer.

2.

Remove the mouse ball from the housing by removing the retaining plate.

3.

Clean the mouse ball.

4.

Pull out any debris from the ball socket, and wipe the ball with a clean, dry cloth.

5.

Reassemble the mouse.

Appendix C Routine Care
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Locating HP resources
This section provides information on the following HP resources for your workstation:
Topics
Product information on page 166
●

Product data sheets

●

HP Cool Tools

●

Regulatory information

●

Accessories

●

System board

●

Serial number and Certificate of Authenticity labels

Product support on page 167
●

Additional information

●

Technical support

●

HP Support Assistant

●

Business Support Center

●

IT Resource Center

●

HP Service Center

●

HP Business and IT Services

●

Warranty information

Product documentation on page 168
●

User and third-party documentation, and white papers

●

Product notifications

●

QuickSpecs

●

Customer Advisories, Security Bulletins, Notices

Product diagnostics on page 170
●

Diagnostics tools

●

Audible beeps and LED code definitions

●

Web-based support tools

Product updates on page 171
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●

Driver and BIOS updates

●

Operating systems
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Product information
Table D-1 Product information
Topic

Location

Product data sheets

See www.hp.com/go/quickspecs.

HP Cool Tools

Most HP Microsoft Windows workstations are preloaded
with additional software that is not automatically installed
during first boot. Additionally, a number of valuable tools
on your workstation are preinstalled that may enhance
system performance. To access or learn more about these
applications, choose one of the following options:
●

Click the HP Cool Tools icon on the desktop, or

●

Open the HP Cool Tools folder by selecting Start >
All Programs > HP Cool Tools.

To learn more about these applications, click HP Cool
Tools—Learn More.
To install or launch the applications, click the appropriate
application icon.
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Regulatory information

Refer to the Safety & Regulatory Information guide for
product Class information. You can also refer to the label
on the workstation chassis.

Accessories

For complete and current information on supported
accessories and components, see http://www.hp.com/go/
workstations.

System board

A diagram of the system board is located on the inside of
the side access panel. Also, additional information is
located in the Maintenance and Service Guide on the Web
at http://www.hp.com/support/workstation_manuals/.

Serial number and Certificate of
Authenticity (COA) labels (if
applicable)

Serial number labels are on the top panel, or on the side of
the unit at the rear, depending on the workstation model.
The COA label is generally located on the top or side
panel near the serial number label. Some workstations
have this label on the bottom of the unit.

Linux

For information on running Linux on HP workstations, see
http://www.hp.com/linux/.
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Product support
Table D-2 Product support
Topic
Additional information

Location
For online access to technical support information and
tools, see http://www.hp.com/go/workstationsupport.
Support resources include Web-based troubleshooting
tools, technical knowledge databases, driver and patch
downloads, online communities, and proactive notification
services.
The following communication and diagnostic tools are also
available:
●

Instant Chat

●

Instant Support

●

Diagnose Problem

Refer to the workstation Maintenance and Service Guide
for more information on how to receive support.
Technical support

Before you call technical support, refer to the workstation
Maintenance and Service Guide for a listing of information
you need to have available before you call.
For a listing of all worldwide technical support phone
numbers, see http://www.hp.com/support/, select your
region, and click Contact HP in the upper-left corner.

HP Support Assistant

HP Support Assistant is an HP application that helps you
maintain the performance of your workstation and resolve
problems through automated updates and tune-ups, built-in
diagnostics, and guided assistance.
To access HP Support Assistant, double-click the HP
Support Assistant icon on your desktop.
NOTE: HP Support Assistant is pre-installed on all HP
workstations with Microsoft Windows 7 operating systems.
HP Support Assistant is not available on workstations
running Linux.
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Business Support Center (BSC)

For software/driver downloads, warranty information,
single-topic documents, user manuals, or service manuals,
see http://www.hp.com/go/bizsupport.

IT Resource Center (ITRC)

See http://www.itrc.hp.com/ for a searchable knowledge
base for IT professionals.

HP Business and IT Services.

For business and IT information, see http://www.hp.com/
hps/.

Product support
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Table D-2 Product support (continued)
Topic

Location

HP Hardware Support Services

For hardware service information, see
http://h20219.www2.hp.com/services/us/en/always-on/
hardware-support-supporting-information.html?
jumpid=reg_R1002_USEN.

Warranty information

To locate base warranty information, see
http://www.hp.com/support/warranty-lookuptool.
To locate an existing Care Pack, see http://www.hp.com/
go/lookuptool.
To extend a standard product warranty, see
http://h20219.www2.hp.com/services/us/en/warranty/
carepack-overview.html?jumpid=hpr_R1002_USEN. HP
Care Pack Services offer upgraded service levels to extend
and expand a standard product warranty.
For some countries/regions, a printed HP Limited Warranty
is provided in the box. In countries/regions where the
warranty is not provided in printed format, you may request
a printed copy from www.hp.com/go/orderdocuments or
write to:
●

North America: Hewlett Packard, MS POD, 11311
Chinden Blvd, Boise, ID 83714, USA

●

Europe, Middle East, Africa: Hewlett-Packard,
POD, Via G. Di Vittorio, 9, 20063, Cernusco s/
Naviglio (MI), Italy

●

Asia Pacific: Hewlett-Packard, POD, P.O. Box 200,
Alexandra Post Office, Singapore 911507

Please include your product number, warranty period
(found on your serial number label), name and postal
address.

Product documentation
Table D-3 Product documentation
Topic

Location

HP user documentation, white
papers, and third-party
documentation

For the latest online documentation, see
http://www.hp.com/support/workstation_manuals. These
include this User Guide and the Maintenance and Service
Guide.

Product notifications

Subscriber's Choice is an HP program that allows you to
sign up to receive driver and software alerts, proactive
change notifications (PCNs), the HP newsletter, customer
advisories, and more. Sign up at www.hp.com/unitedstates/subscribe/gateway/?jumpid=go/subscribe-gate1.
Customer advisories and product change notifications are
also available on http://www.hp.com/go/bizsupport/.
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Topic

Location

Workstation technical overview and
specifications

The Product Bulletin contains QuickSpecs for HP
Workstations. QuickSpecs provide an overall specification
review of your product. It includes information about its
features including the operating system, power supply,
memory, CPU, and many other components of the system.
To access the QuickSpecs, see http://www.hp.com/go/
quickspecs/.

Customer Advisories, Security
Bulletins, and Notices

To find advisories, bulletins, and notices:
1.

See http://www.hp.com/go/workstationsupport.

2.

Select the desired product.

3.

From the Resources section, select See more…

4.

Use the scroll bar to select Customer Advisories,
Customer Bulletins, or Customer Notices.

Product documentation
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Product diagnostics
Table D-4 Product diagnostics
Topic

170

Location

Diagnostics tools

The HP Vision Diagnostics utility can be found as a
burnable ISO image on the workstation hard disk (under C:
\VisionDiagnostics), or can be downloaded from the
HP web site. For details on using this utility, refer to the
section that covers HP Vision Diagnostics in the workstation
Maintenance and Service Guide.

Audible beep and LED code
definitions

Refer to the appropriate section of the workstation
Maintenance and Service Guide for detailed information
about beep and Light Emitting Diode (LED) codes
applicable to the workstation.
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Product updates
Table D-5 Product updates
Topic
Driver and BIOS updates

Location
See http://www.hp.com/go/workstationsupport to verify that
you have the latest drivers for the workstation.
To determine the current workstation BIOS on your
workstation, follow these steps during system power up:
1.

Power on the workstation, and wait for F10=setup to
appear on the lower right corner of the screen.

2.

Press F10 to enter the F10 Setup utility.
The F10 Setup utility displays the computer BIOS version
under File > System Information.

3.

Operating systems

Note the computer BIOS version so that you can
compare it with the BIOS versions that appear on the HP
website.

For information on operating systems supported on HP
workstations, see http://www.hp.com/go/wsos.
For information on Windows operating systems, see
http://www.microsoft.com/support.
For information on Linux operating systems, see
http://www.hp.com/linux.
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Converting to desktop
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CPU 101
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Rear system fan 82
Service considerations 55
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